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About This Book

This book first describes the new features of OS/2 Warp Server for e-business, and
then leads you through planning, installing, and configuring the product.

Who Should Read This Book

This book is for network administrators who are experienced with OS/2 and local area
networks (LANs). Network administrators install, manage, control, and configure a
network. They also define the resources to be shared, and they determine who can use
those resources. Network administrators ensure that all or part of any program available
on the network is shared according to the applicable program license agreement or
conditions of use.

Conventions and Terminology Used in This Book

The following conventions are used in this book:

» Boldface type indicates the name of an item you need to select, field names, and
folder names. It also indicates controls (when used in procedures), such as:

— Menu bar choices

— Radio buttons

— Push buttons

— List boxes

— Check boxes

— Entry fields

— Read-only entry fields

 [talic type indicates technical terms, book and diskette titles, words of emphasis, or
variable information that must be replaced by an actual value.

« UPPERCASE TYPE indicates a file or directory name, command name, or acronym.

* Monospace type indicates coding examples, special characters, text you must type, or
text displayed on the computer screen.

Double-Byte Character Set (DBCS) Information

OS/2 Warp Server for e-business runs on both single-byte character set (SBCS)
systems and double-byte character set (DBCS) systems. SBCS is a graphic character
set in which each character occupies 1 byte. DBCS is a graphic character set in which
each character occupies 1 or 2 bytes. Languages such as Japanese and Chinese,
which contain more symbols than can be represented by 256-code combinations,
require double-byte character sets.

© Copyright IBM Corp. 1999 Xi



Related Books and Information

The publications and online information listed below give details about components and
products not covered in this book.

0S/2 Warp Server for e-business Publications

Additional documentation and help is provided in the following formats:

Online Help

Online help provides information about general topics, procedures, and messages.
There are several ways to access online help:

« For context-sensitive help for a window, press F1 or click the Help menu or button.

» Select a topic from the Help Index by opening the Assistance Center folder, and
then opening the Information folder.

* To view command-line help, type help at an OS/2 command prompt and press Enter.
For help on a specific command, type help, followed by the command. For example,
for help about the LVM command, type help 1vm and press Enter. For a two-word
command, such as net use, type help "net use" and press Enter.

Online Books

To view an online book, open the Assistance Center folder, and then open the
appropriate folder. Click the category you want, and then open the book that you want
to view.

After you open a book, you can click on links to other topics, search for specific
information, or print the entire book or a portion of the book.

See Using Online Information in the Assistance Center folder for book names and
descriptions.

The OS/2 Warp Server for e-business book library contains occasional references to
book titles that are not listed above. The following table lists possible references and
their corresponding book:
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If you see a reference to:

7

'hen refer to this book:

0S/2 Warp LAN Server Network Administrator
Reference, Volume 1: Planning, Installation,
and Configuration

Planning, Installation, and Configuration

0S/2 LAN Server Up and Running!

Quick Beginnings

0S/2 Warp LAN Server Network Administrator
Reference, Volume 2: Performance Tuning

Performance Tuning

0S/2 Warp LAN Server Network Administrator
Reference, Volume 3: Network Administrator
Tasks

Network Administrator Tasks

IBM Multi-Protocol Transport Services—AnyNet
for OS/2: Configuration Guide

MPTS Configuration Guide

0S/2 Warp Desktop Guide

0S/2 Desktop Guide

0S/2 Warp Command Reference

LAN Server 4.0 Commands and Ultilities

Command Reference

Troubleshooting

Problem Determination Guide

Serviceability and Troubleshooting Guide

PostScript-Formatted Books

The OS/2 Warp Server for e-business Server Pak CD contains compressed (zipped)
PostScript versions of the following books in the \BOOKS\PSZIP directory:

Title of Book Zipped Filename
Migrating to OS/2 Warp Server for e-business, | MIGRATE.ZIP
S5G24-5135
Network Administrator Tasks NETADMIN.ZIP

0S/2 Keyboards and Codepages

KEYBOARD.ZIP

Performance Tuning

PERFTUNE.ZIP

Quick Beginnings

INSTALL.ZIP

Uncompressing a Zipped PostScript File:

Each PostScript book is compressed with

the PKZIP2.EXE utility. You can uncompress each book with the PKUNZIP2.EXE utility
that is included with OS/2 Warp Server for e-business. You must uncompress the book
file on a computer that has PKUNZIP2.EXE or a similar utility.

To uncompress a zipped PostScript file:
1.
2.
3.

Open an OS/2 window.

pkunzip2 e:\books\pszip\filename

Insert the OS/2 Warp Server for e-business Server Pak CD into the CD-ROM drive.

Type the following command and press Enter:
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where e: is your CD-ROM drive letter and filename is the zipped PostScript file
name.

For example, to uncompress the file named NETADMIN.ZIP, type the following
command and press Enter:

pkunzip2 e:\books\pszip\netadmin.zip
Note: The file extension on the uncompressed PostScript file is .PS.

Printing a PostScript Book File: After you uncompress a PostScript book, you can
print it from a computer on which a PostScript-compatible printer object is defined on
the Desktop.

To print a PostScript file after you have uncompressed it:
1. Make sure that the correct driver is selected in the printer object’s settings.
The word PSCRIPT should be part of the driver name.

2. Open the OS/2 System folder, and then open the Drives folder on the OS/2
Desktop.

3. Open the drive, and then the folder where the PostScript file is located.
4. Drag the file object onto your PostScript printer object.

PDF-Formatted Books

The OS/2 Warp Server for e-business Server Pak CD contains PDF (Portable
Document Format) versions of the following books in the \BOOKS\PDF directory:

Title of Book Filename
Migrating to OS/2 Warp Server for e-business, | MIGRATE.PDF
SG24-5135
Network Administrator Tasks NETADMIN.PDF
0S/2 Keyboards and Codepages KEYBOARD.PDF
Performance Tuning PERFTUNE.PDF
Quick Beginnings INSTALL.PDF

Viewing a PDF File:  You can view, navigate, and print any PDF book from a
computer that has Adobe Acrobat Reader or a similar program. You can obtain a copy
of Adobe Acrobat Reader from the Internet at the following address:

http://www.adobe.com

To view the PDF book after you have installed Adobe Acrobat Reader:
1. Start Adobe Acrobat Reader.
2. Click Open from the File pull-down menu.
The Open window is displayed.
3. Click the drive letter of your CD-ROM drive.
4. Click the BOOKS\PDF directory.

0OS/2 Warp Server for e-business: Quick Beginnings: Installing OS/2 Warp Server for e-business



5. Click the file name of the book you want to open.
6. Click the Open button.

HTML-Formatted Books

The OS/2 Warp Server for e-business Server Pak CD contains compressed (zipped)
HTML versions of the following books in the \BOOKS\HTMLZIP directory:

Title of Book Filename

Migrating to OS/2 Warp Server for e-business, | MIGRATE.ZIP
5G24-5135

Uncompressing a Zipped HTML File: Each HTML book contains several files that
are compressed with the PKZIP2.EXE utility. You can uncompress each book with the
PKUNZIP2.EXE utility that is included with OS/2 Warp Server for e-business. You must
uncompress the book file on a computer that has PKUNZIP2.EXE or a similar utility.

Note: Before you uncompress a zipped HTML file, you should create a directory where
you want to place the unzipped HTML files.

To uncompress a zipped HTML file:
1. Insert the OS/2 Warp Server for e-business Server Pak CD into the CD-ROM drive.
2. Open an OS/2 window.
3. Type the following command and press Enter:
pkunzip2 e:\books\htmlzip\filename x:\book

where e: is your CD-ROM drive letter, filename is the zipped HTML file name, and
x:\book is the drive letter and directory name where you want to place the unzipped
HTML files.

For example, to uncompress the file named MIGRATE.ZIP to a directory named
D:\BOOK, type the following command and press Enter:

pkunzip2 e:\books\htmlzip\migrate.zip d:\book

Viewing an HTML File:  You can view, navigate, and print any HTML book from a
computer that has an HTML browser. Netscape Communicator is included on the 0OS/2
Warp Server for e-business CD.

To view the HTML book:

1. Start the HTML browser.

2. Click Open from the File pull-down menu.

The Open window is displayed.

Click the drive letter of the directory where you unzipped the HTML files.
Click the directory where you unzipped the HTML files.

Click the file name of the book you wish to open.

Click the Open button.

ook w
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Redbooks about OS/2 Warp Server for e-business

The International Technical Support Organization (ITSO) provides redbooks, both
printed and online, with information about various products. Redbooks, named for their
red covers, are "how to” books written by IBM professionals worldwide.

Look for information about the following OS/2 Warp Server for e-business redbooks on
the Internet at http://www.redbooks.ibm.com:

e Migrating to OS/2 Warp Server for e-business, SG24-5135
e Inside OS/2 Warp Server for e-business, SG24-5136
* Beyond DHCP--Work Your TCP/IP Internetwork with Dynamic IP, SG24-5280

Technical Databases for OS/2 Products

Personal Software Services provides technical information and assistance for the
Personal Systems Support Family (PSSF) of products. This includes support for OS/2,
PC DOS, and IBM software applications that run on PC operating systems, including
Windows NT.

You can browse and search technical databases and download fixes or device drivers
on the Internet at http://ps.software.ibm.com.
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Chapter 1. Overview of OS/2 Warp Server for e-business

Congratulations on choosing IBM OS/2 Warp Server for e-business. OS/2 Warp Server
for e-business provides server functionality in both single microprocessor (uniprocessor)
and symmetrical multiprocessor (SMP) configurations.

This software is part of the IBM Software Servers family of IBM and Lotus products.
0OS/2 Warp Server for e-business is a platform for multifunction, compatible servers
covering a broad range of needs from an entry-level database server to a server for
comprehensive systems management of sophisticated networks. OS/2 Warp Server for
e-business also provides workgroup functions with Lotus Domino and gets you up and
running quickly as a server on the Internet.

OS/2 Warp Server for e-business provides performance and capacity enhancements for
both single and multiple processor systems. The installation process determines the
processor configuration, installs both the uniprocessor and SMP kernels on the hard
drive, and uses the appropriate kernel.

Because many corporations use the Configuration, Installation, and Distribution (CID)
installation process, enhancements to that process were a priority. OS/2 Warp Server
for e-business includes a shell to collect installation data and to generate a response
file for input to the CID installation of individual services. All operating system services
are CID-installable. For detailed information about CID changes and enhancements,
see the README.CID file on the Installation Diskette and Migrating to OS/2 Warp
Server for e-business, SG24-5135 on the OS/2 Warp Server for e-business Server Pak
CD.

The processes to prepare the hard disk for installation have been updated. OS/2 Warp
Server for e-business Logical Volume Manager support, described in
Manager” on page 3, lets you define file systems that span physical disks. You can
define a Journaled File System (JFS) that gives you larger file capability and enhanced
recovery compared to other OS/2 file systems.

New hardware that becomes available after OS/2 Warp Server for e-business is
installed can be supported with modifications to the diskettes used to start the
installation process.

OS/2 Warp Server for e-business adds value to your existing LAN by providing
interoperability with other LANs. OS/2 Warp Server for e-business interoperates with:
e 0OS/2 Warp Server and previous OS/2 LAN Server releases

* 0OS/2 LAN Server clients, such as WorkSpace on-Demand, OS/2 Warp 4, OS/2 Warp
3, DOS LAN Services, and LAN Support Program (LSP)

* LAN Server on VM, MVS, AIX, and AS/400
* Microsoft NT servers

* Microsoft Windows NT/98/95/ clients

* Microsoft Windows for Workgroups

© Copyright IBM Corp. 1999 1



» Microsoft LAN Manager clients and servers
 Artisoft LANTastic
* DEC Pathworks

The following sections provide an overview of the major components of OS/2 Warp
Server for e-business. Updated or discontinued components are also listed. See

[Chapter 3_Preinstallation Planning” on page 13 for details to help you determine which

installable and configurable components are right for you.

i ]

0S/2 Base Operating System

The base operating system for OS/2 Warp Server for e-business is an advanced,
multitasking, 32-bit operating system that runs DOS, Windows, and OS/2 16-bit and
32-hit applications and utilizes SMP hardware configurations.

2 0S/2 Warp Server for e-business: Quick Beginnings: Installing OS/2 Warp Server for e-business



Logical Volume Manager

The Logical Volume Manager (LVM) provides flexibility for configuring and managing
disk drives on your system. LVM replaces the Fixed Disk Utility (FDISK). Disk drives
and partitions are configured as logical volumes with a new set of utilities, which
supports the following enhancements:

* The drive letter for a disk volume is explicitly assigned when the volume is added,
and it is persistent across OS/2 system restarts.

* A disk volume drive letter can be changed at any time; however, drive letters
assigned to operating system volumes should not be changed. See [Chapter 5]

Creating and Managing Volumes and Hard Disk Partitions” on page 53 for more

information.

* Under most conditions, OS/2 does not need to be rebooted after a disk volume drive
letter is added or changed.

* The disk volume drive letters do not need to be contiguous.

* CD-ROM drive letters can remain unchanged when disk volumes are added.

* LAN drive letter assignments can remain unchanged when disk volumes are added.
» Logical volumes can span multiple partitions and physical disks.

For detailed information about LVM, see tLagical Violume Manager” on page 19,

Journaled File System

The Journaled File System (JFS) is a scalable, 32-bit, performance-oriented file system.
To facilitate quick recovery and restart after system failures, JFS uses database
journaling techniques, enabling it to restore file systems quickly, which contributes to
improved server availability. JFS raises the previous file-size limit of 2 gigabytes (GB) to
2 terabytes (TB). The partition size limit is raised from 64GB to 2TB. JFS volumes can
be increased in size, using Logical Volume Manager (LVM), without having to be
reformatted.

For detailed information about JFS, see Llournaled File System (IES)” on page 20.

Year 2000 and the Euro

0OS/2 Warp Server for e-business is fully enabled to support the Year 2000 (Y2K) and
euro currency transitions.

The new currency in Europe goes by the name euro. The euro is the monetary unit of
the European Monetary Union (EMU) that was introduced alongside national currencies
on the first of January 1999. The original members of the EMU are Austria, Belgium,
Finland, France, Germany, Ireland, Italy, Luxembourg, the Netherlands, Portugal, and

Chapter 1. Overview of OS/2 Warp Server for e-business 3



Spain. The national currencies of these countries have a fixed exchange rate with the
euro, and will be withdrawn after a transition period, which is planned for completion in
2002.

Support for the euro sign as the currency symbol is available when you specify country
information during the installation process.

Updated Desktop

The Desktop in OS/2 Warp Server for e-business is based on the Desktop of OS/2
Warp 4. In addition, new icons are on the Desktop, and some existing icons are in a
different location than they were in previous versions of OS/2 Warp Server. Take a few
minutes after installing OS/2 Warp Server for e-business to become familiar with the
new Desktop. Refer to OS/2 Desktop Guide for more information about the Desktop.

File and Print Sharing Services

File and Print Sharing Services enables the server to share directories, printers, and
serial devices across a local area network (LAN).

TCP/IP Services

TCP/IP Services enables the server to distribute the TCP/IP Internet protocol
configuration to client workstations. Highlights of the TCP/IP services include:

* Dynamic Host Configuration Protocol (DHCP) enhancements, which include Remote
IPL (RIPL) support and BootP server capability

» Dynamic Domain Name Server (DDNS) enhancements, which enable the network
administrator to more easily manage IP addresses
* Improved buffer management, resulting in increased performance

* Improved printer streaming and printer security

Refer to the TCP/IP online documentation in the Assistance Center folder on the
Desktop for details about TCP/IP configuration after installation. Additional information is
available in the redbook Beyond DHCP--Work Your TCP/IP Internetwork with Dynamic
IP, SG24-5280.

Netscape Communicator

Netscape Communicator 4.04b lets you access and navigate the Internet with Netscape
Navigator, send and receive e-mail with Netscape Messenger, keep track of the latest
postings in your favorite newsgroups with Netscape Collabra, and create your own Web
pages with Netscape Composer. Some applications and services, such as those found
at IBM Software Choice, use the browser as a graphical user interface (GUI) for
installing, uninstalling, or updating other software programs.
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Java Support

The OS/2 Warp Developers Kit, Java Edition, Version 1.1.7 delivers a full
implementation of Java, including both the Runtime and Development packages. This
release improves performance and provides euro support. Significant enhancements in
graphics, throughput, and scalability set new standards for Java Virtual Machine (JVM)
performance.

Neighborhood Browser Enabler

The Neighborhood Browser Enabler is an OS/2 Warp Server for e-business service that
functions as a master browser for Windows clients. The master browser service permits
0OS/2 Warp Server for e-business domain resources to be viewed and shared from the
Windows NT 4.0, Windows 98, and Windows 95 Network Neighborhood.

Windows NT User Account Manager

The Windows NT User Account Manager eases the management of user and group
accounts in a heterogeneous server environment. This feature allows user and group
accounts that are defined and managed in the OS/2 Warp Server domain to be
replicated to a Windows NT 4.0 server.

LDAP Client Support

OS/2 Warp Server for e-business supports the Lightweight Directory Access Protocol
(LDAP), a standards-based Internet directory protocol.

The OS/2 LDAP Client Toolkit for C and Java Version 1.0 is for C and Java
programmers who want to enable new or existing applications to access, search, and
update LDAP servers, using LDAP V2 or LDAP V3 protocols.

120 Support

0OS/2 Warp Server for e-business helps simplify the attachment of new devices. 120 is
an industry-standard architecture that defines a new interface between a processor and
I/0 adapters. This specification provides for movement of function from the system CPU
to the adapter card. Use of 120, either on the system board or as an adapter in servers,
reduces the CPU load, which helps increase system throughput. OS/2 Warp Server for
e-business supports 120 for SCSI adapters and for ethernet and token-ring LAN
adapters.

Chapter 1. Overview of OS/2 Warp Server for e-business 5



Tivoli Management Agent

The Tivoli Management Agent (TMA) extends the client/server hierarchy and enhances
the scalability of a Tivoli Management Environment (TME). TME is a systems
management tool for enterprise-wide, heterogeneous networks. The TMA increases the
number of resources that can be managed and, at the same time, enables those
resources to be used more efficiently.

Besides providing full functionality down to the endpoints, the TMA reduces the physical
requirements to manage a system. The TMA is a replacement for the SystemView
agent and supports OS/2 using TCP/IP.

Lotus Domino Go Webserver and IBM WebSphere Application Server

OS/2 Warp Server for e-business includes Lotus Domino Go Webserver 4.6.2.6. Lotus
Domino Go Webserver is a scalable, high-performance Web server that is easy to
install and maintain. It includes state-of-the-art security, site indexing capabilities, and
support for JDK 1.1.x. Lotus Domino Go Webserver makes it possible to maintain a
productive Web presence in a diverse and dynamic environment.

After you install Lotus Domino Go Webserver, you can add Java support by installing
IBM WebSphere Application Server 1.1. IBM WebSphere Application Server is a plug-in
for Lotus Domino Go Webserver and includes:

* A Java servlet engine that implements the JavaSoft Java Servlet API

* |BM additions and extensions to the Java Servlet API for enhanced session tracking
and personalization

« Support for JavaServer Pages (JSP), a powerful approach to dynamic Web pages

* A database connection manager for caching and reusing connections to
JDBC-compliant databases

» Data access JavaBeans (additional Java classes for accessing JDBC-compliant
databases)

* CORBA Support—an object request broker (ORB) and a set of services that are
compliant with the Common Object Request Broker Architecture (CORBA)

Personally Safe 'n’ Sound Backup and Recovery

Personally Safe 'n’ Sound (PSnS Backup and Recovery) is a powerful backup utility
that lets you safeguard your OS/2 system against loss of data. It allows you to set up a
Backup Strategy for each activity you perform on your machine. The strategy, once
employed, provides protection against all of the likely causes of data loss: user errors,
hardware malfunctions, malicious damage, and disasters.

For more information about using PSnS, see OS/2 Warp Server Backup/Restore User’s

Guide and the other online books that come with it. More information is available on the
Internet at the following address:
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http://www.software.ibm.com/os/warp/warp-server

Advanced Print Services

Advanced Print Services, also known as Print Services Facility/2 or PSF/2, allows you
to print file formats that your printer typically does not support. Advanced Print Services
automatically performs data stream transformations to convert the data in a document
into the type of data required by the printer. For example, Advanced Print Services can
transform a PostScript document into an advanced function presentation (AFP)
document that can be printed on a high-speed IBM printer, or it can transform an AFP
document into one that can be printed on an HP LaserJet printer.

Advanced Print Services lets users send print jobs from computers running OS/2,
Windows, DOS, or AlX.

Remote Access Services

Remote Access Services, a replacement for LAN Distance, includes a remote access
server that allows NetBIOS and point-to-point protocol (PPP) clients, including Microsoft
Windows NT, Windows 98, Windows 95, IBM OS/2 Internet Dialer, and IBM 8235 users,
to remotely access the LAN. The following services are available:

= Answering incoming calls to establish connections

* Routing and filtering data to bridge the Remote Access Client workstation to the LAN
* Providing security for LAN resources

» Performing other administrative functions for the wide area network (WAN)

» Assigning IP addresses with DDNS support

Remote Access Services allows multiple remote workstations to dial in concurrently and
access LAN resources. The number of remote workstations supported is determined by
your server’s processing power and its communications adapters.

Additional New Features

The following additional features are new with OS/2 Warp Server for e-business:

* Long format option during installation. See LEarmatting the Installation Volume” ad

for more information.

* CHKINST.EXE "software sniffer” utility checks the system prior to installation to
determine what preparation is required and then reports the results. See

System Checking Utility” on page 24 and Migrating to OS/2 Warp Server for

e-business, SG24-5135 for more information.

* Increase in maximum number of ACLs, open files, connections, searches, and
shares. The maximum number of ACLs for the Journaled File System (JFS) is limited
only by available disk space. The following capacity parameters in the Server section
of the IBMLAN.INI file have been increased:
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maxopens
maxsearches
maxconnections
maxshares

These changes increase the number of users, files, searches, and shares the server
can maintain. See Performance Tuning for more information.

Replaced or Discontinued Components

The following components, previously installed with OS/2 Warp or OS/2 Warp Server,
are replaced in OS/2 Warp Server for e-business:

Fixed Disk Utility (FDISK.COM), replaced by Logical Volume Management Tool
(LVM.EXE)

Fixed Disk Presentation Manager Utility (FDISKPM.EXE), replaced by Logical
Volume Manager Graphical User Interface (LVMGUI.CMD)

Java 1.0, replaced by Java 1.1.7

Pulse, replaced by CPU Monitor (CPUMON)

LAN Distance, replaced by Remote Access Services

SystemView Agent (Netfinity TME 10), replaced by Tivoli Management Agent (TMA)

The following components, previously installed with OS/2 Warp or OS/2 Warp Server,
are not part of OS/2 Warp Server for e-business:

Password Coordinator

Network Signon Coordinator

BonusPak

0S/2 Warp Tutorial

OpenDoc

WarpGuide

VoiceType

Hibernate (Trapdoor)

Novell NetWare Client for 0S/2

Dual boot is not supported

Easy Path installation

Mobile File Sync

PCOMM Lite 4.1

Keyworks

HP JetAdmin

Installation from diskettes, replaced by installation from CD
Remote client installation is not supported
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Chapter 2. Requirements for the Server

Prior to installing OS/2 Warp Server for e-business, make sure you have the required
hardware and software and that your hardware is supported by OS/2 Warp Server for
e-business.

Supported Hardware

You can find the most current information on supported hardware and additional device
support on the Internet at the following address:

http://www.software.ibm.com/os/warp/support

The Personal Computer Manufacturer (PCM) table lists systems that have been tested
and verified to work with OS/2. The PCM table is available at the following address:

http://www.software.ibm.com/os/warp/hw-cert

New hardware that becomes available after OS/2 Warp Server for e-business is
installed can be supported with modifications to the diskettes used to start the
installation process. You can find the most current information on additional device
drivers on the Internet at the following address:

http://service.software.ibm.com/os2ddpak/index.htm

See Madifying the Installation Diskettes for New Hardware” on page 74 to add a device
driver to the installation diskettes or to replace a driver that was included on the
diskettes.

System Requirements

To install OS/2 Warp Server for e-business and use its services on the server, you need
at least the following minimum hardware:

* One or more Intel-compatible Pentium or higher processors with a speed of at least
133 MHz.

Note: A multiprocessor system must either comply with the Intel Multiprocessor
Specification, Version 1.4 or 1.1, or it must be one of the following computers,
each of which has its own proprietary SMP architecture:

— Compagq Proliant 2000
— Tricord PowerServer, models 30 and 40
— IBM PC Server 720

e A minimum of 32MB of random access memory (RAM), but 64MB or more provides
better performance, depending on which services are installed.
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* A minimum of 120MB of available hard disk space for the base operating system. A
minimum of 200MB is required for the base operating system and all default
installation items. A total of 500MB is recommended for a typical installation,
depending on which services and components are installed. For installation
requirements of services and components, see the table in

* A 1.44MB, 3.5-inch diskette drive, configured as drive A.
e A 640 x 480 (16-color) or higher resolution VGA display.
¢ An IBM-compatible mouse.

* A CD-ROM drive supported by OS/2.

* A LAN adapter card supported by MPTS.

» Remote Access Services requires the supported remote access adapters, which are
a subset of the supported MPTS LAN adapters.

* A modem that supports speeds of 9600bps or higher, if you plan to use Remote
Access Services.

* An Internet-enabled LAN or a modem, if you plan to use the Internet.

Hard Disk Space Requirements

Note: The requirements in this section are based on information available at
publication time.

Service Number csz I\l/?l);:‘gabytes

Default installation: OS/2 base operating system plus default 120.0
components

All optional OS/2 components 180.0
File and Print Sharing Services 15.0
TCP/IP Services 30.0
Remote Access Services 6.0
Netscape Communicator 11.0
Tivoli Management Agent 15
Personally Safe 'n” Sound 7.2
LDAP Services Toolkit 4.2
Advanced Print Services 54.0
First Failure Support Technology (FFST) 1.2 0.1
Online Books 10.0
Total (if all components and services are installed) 439.0
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Keyboards Supported during Installation

For SBCS versions of OS/2 Warp Server for e-business, code page 850 is the only
code page that is supported during the first phase of the installation process or if you
start the system from utility diskettes. As a result, you must select one of the Latin-1
keyboards, even if you normally select a non-Latin-1 keyboard. You can still set the
country code to any valid country. This setting may affect the default country and
keyboard settings used later in the installation process, including those used by the
Logical Volume Management Tool (LVM), and for command line processing when the
system is booted from utility diskettes. However, later in the installation, you can specify
your preferred country and keyboard settings.

The following keyboards are supported during the first phase of OS/2 Warp Server for
e-business installation:

Country Code Country Name
be Belgium
br Brazil
cf Canadian French
dk Denmark
fr France
gr Germany
it Italy
la Latin America
nl Netherlands
no Norway
sf Swiss French
sg Swiss German
sp Spanish
su Finland
sV Sweden
uk United Kingdom
us United States
ux US International

Display and Graphics Adapter Considerations

The installation program automatically detects graphics adapters or chips in your
system, and it automatically selects an appropriate graphics driver. If your graphics
adapter is not recognized, the installation program defaults to a driver that supports
VGA mode only (640 x 480 resolution with 16 colors). If that happens, you can find
instructions on how to obtain and install support specifically for your adapter from OS/2
Device Driver Pak Online at the following address:
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http://service.software.ibm.com/os2ddpak/index.htm

If you find no specific driver for your graphics adapter, consider installing the Generic
VESA Unaccelerated GRADD (GENGRADD) to obtain Super VGA resolutions and color
support.

If you experience video problems after you have installed a graphics device driver, use
the following steps to correct the problem:

1. Restart the system.

2. When the white band OS/2 is displayed in the upper-left corner of the screen, press
Alt+F1.

3. Press F3 to reset the system to VGA mode.

Ensure that your display is capable of synchronizing to the refresh rates that your
graphics adapter is capable of setting. Some graphics adapters implement an
EEPROM, which may be programmed with specific refresh timings for each resolution.
Verify that these timings are compliant with your monitor’s capabilities prior to
installation. This verification is generally a matter of running the adapter utility that
accompanied the adapter card or system unit.

For example, ATl Mach32 adapters should be configured to run at 60Hz VGA resolution
(640 x 480, 16-color resolution) prior to installation.
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Chapter 3. Preinstallation Planning

Before installing OS/2 Warp Server for e-business, you should be familiar with concepts
and terminology related to installation, including Logical Volume Manager, Journaled
File System, and information about selecting a file system.

While LChapter 1_Qverview of QS/2 Warp Server for e-husiness” an page 1| gave you
an overview of the product, this section explains new concepts in greater detail,
allowing you to make informed decisions about configuring your network before you
begin installation.

Review the following concepts and terminology before you install OS/2 Warp Server for
e-business:

Terminology

Before you install OS/2 Warp Server for e-business, you should be familiar with the
terminology listed below:

Active partition
The one primary partition that has the boot indicator set in the master boot
record. One primary partition must be marked active to start the computer from
a hard disk. On most computers, this must be the first hard disk. The active
partition must contain an operating system or a program, such as Boot
Manager, from which you can select a partition that has an operating system.

Extended partition
An extended partition is defined in the master boot record of a hard disk, but it
must be divided into one or more logical partitions to be used. This
arrangement exists to overcome the small limit of four primary partitions. The
maximum number of logical partitions within an extended partition is not a fixed
number, but it is limited only by installation-dependent, practical considerations.

Note: The Logical Volume Manager (LVM) utilities do not display or directly
allow configuration of extended partitions. Operations on logical
partitions are automatically performed within an extended patrtition.

File system
The function that stores data and indexing information on disk sectors, using a
particular arrangement and method to access it. A disk volume must be
capable of holding data to be used by applications and a directory structure for
applications to organize and locate data. To prepare a volume for use by a file
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system, a formatting program is executed to create the indexing and directory
infrastructure. After formatting is completed, the volume can be used by
applications. In OS/2 Warp Server for e-business, a volume can be formatted
for use by JFS, 386 HPFS, HPFS, or FAT file systems. Note that volumes
cannot be formatted within the LVM utility.

Free space
The area on a hard disk that has not been allocated as partitions for use by a
file system or an operating system. To use free space on a hard disk, you
must first allocate the space into a volume using LVM, and then format the
volume for a particular file system.

Hard disk
A physical device used to store data. A hard disk may have a label, or name,
assigned to it. A hard disk can be divided into one or more partitions.

Logical partition
Logical partitions are defined within an extended partition, but are otherwise
similar to primary partitions. There are operating system-dependent restrictions
on booting from logical partitions, so they are generally used for data. OS/2
does not restrict booting from logical partitions. As a result, it can be installed
on a logical partition as long as Boot Manager is installed on the active
(bootable) primary partition.

Partition
A physical segment on a hard disk that has been allocated for use by a file
system or an operating system. A partition may have a label, or name,
assigned to it, but it does not have a drive letter assigned to it. A hard disk
may contain one or more partitions.

Partitions can be one of three types: primary, extended, or logical.

Primary partition
Primary partitions are defined in the master boot record on the first sector of
each hard disk. A physical disk can have a maximum of four primary partitions,
or three primary partitions and one extended patrtition.

Volume
Storage space on a hard disk that has been assigned a drive letter for use by
a file system or operating system. A volume may contain one or more
partitions, and it may have a label, or name, assigned to it. A logical volume
may consist of one or more partitions, and it is logically treated as if it were a
single, contiguous partition.

Two types of volumes are possible with LVM: compatibility volumes and LVM

volumes. See [Lagical Volumes” on page 1 for more information about these

types of volumes.
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Boot Manager

Boot Manager allows you to install more than one operating system on the same hard
disk. A system configured with Boot Manager displays a menu at startup that allows you
to choose which operating system to boot from. Each operating system resides in its
own volume.

To install and set up Boot Manager, you must use the Logical Volume Management Tool
(LVM). This can be done during installation.

If Boot Manager is not installed, then the installable volume must be set to C:.
You should install the base operating system into its own volume (set as installable), so

that if reinstallation becomes necessary, you can format the volume and then install the
operating system to the newly formatted volume without affecting applications and data.

Logical Volume Manager

Logical Volume Manager (LVM) is a set of new OS/2 disk management functions and
utilities. LVM allows user configuration of physical and logical volumes (usually referred
to as drives in previous versions of OS/2) with much greater flexibility than before.
Features such as persistent drive letters, dynamic drive letter assignment, disk
spanning, and dynamic volume expansion greatly reduce downtime when disk
configuration changes are made on a server.

LVM Utilities

The Logical Volume Management Tool (LVM.EXE) is used to configure new LVM
features as well as perform basic partitioning functions, which were done with the Fixed
Disk Utility (FDISK.COM) in previous versions of OS/2.

A new Java application, Logical Volume Manager Graphical User Interface
(LVMGUI.CMD), likewise replaces the previous FDISK Presentation Manager utility
(FDISKPM.EXE).

The utilities FDISK and FDISKPM are not included with OS/2 Warp Server for
e-business.

Note: After volumes have been created with LVM, FDISK should no longer be used to
manage partitions.

The following chart illustrates the differences between drives as they were defined by

FDISK and drives as they are defined by LVM. Note that with FDISK, a partition is
equivalent to a drive. However, with LVM, a volume is equivalent to a drive.
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FDISK LVM

Partition - A physical segment on a hard disk. Logical Volume - May consist of one or more
partitions; treated as if it were a single,
contiguous partition.

Primary Volume may
partition is . . consist of . .
equivalent C. D' one partition C' D'
to a drive. as in FDISK.

primary primary ~ extended

partitionpartition  partition partiton  partition  partition
Extended Volume may
partition consist of
may include C: | D:| E: F: two or more E: F: E:
one or more partitions; may
logical drives. be noncontiguous.

oskt| C: | D: | E: | F: wm | oisk1 | E: F: E:

Partitions volume
cannot be may be
linked linked
across across
hard disks; one or
must be more
contiguous. hard

pisk2| G H: | disks. | DISk2| - Z: G:

Drive letters are assigned by system Drive letters are assigned by user, or
in alphabetical order. default to assignment by system
in alphabetical order.

Figure 1. Comparison chart of FDISK and LVM concepts.
Starting the LVM Ultilities after Installation

For your convenience, volume management and configuration functions are available
with three LVM interfaces: text mode window, graphical user interface (GUI), and
command line. The table below lists the three interfaces, how to access each interface
after installation is completed, and where to find more information about performing
volume management tasks in each interface.

Table 1. Logical Volume Manager Interface Options

How to start LVM after Where to find additional
LVM Interface Type installation is complete LVM task information
Text mode window 1. Open an OS/2 window. [Chapter 5 Creating and
Managing \olumes and Hard
2. Type lvm and press Enter. Bisk Partifions” e
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Table 1. Logical Volume Manager Interface Options (continued)

How to start LVM after Where to find additional
LVM Interface Type installation is complete LVM task information
Graphical user interface (GUI) Network Administrator Tasks

1. Open the OS/2 System
folder on the Desktop.

2. Open System Setup.

Double-click the Logical
Volume Manager icon.

or
Open an OS/2 window.

2. Type lvmgui and press
Enter.

Command line 1. Open an OS/2 window. Command Reference

2. Type 1vm followed by
command line parameters
and press Enter.

For information about valid
parameters, type help 1vm and
press Enter to display the
Command Reference.

Logical Volumes

A logical volume is one or more partitions with an associated drive letter. It is treated as
if it were a single, contiguous partition. Volumes have persistent drive letters associated
with them. Partitions that are not part of a logical volume have no associated drive letter
and cannot be accessed by applications. You can create two types of logical volumes
with LVM: compatibility volumes and LVM volumes. Each volume created by LVM has a
volume designation.

Compatibility Volumes
A compatibility volume is compatible with previous versions of OS/2 and other operating
systems. It corresponds to a single physical partition on a single physical hard disk, and

it can be made bootable. When you install OS/2 Warp Server for e-business, you will
create a compatibility volume and set it installable to be the target for installation.

LVM Volumes

An LVM volume is a new type of volume that is not recognized or accessed by previous
versions of OS/2 or other operating systems.
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Volume Designations

Four types of volume designations are possible with LVM: bootable, installable,
nonbootable, and startable.

Bootable
Bootable is a volume designation, used by Logical Volume Manager, indicating
that the volume contains a bootable operating system. When a bootable
volume is created, it is automatically added to the Boot Manager menu. For
example, if you have two operating systems installed in two different volumes
on your computer, you can designate each volume as bootable. Then, using
Boot Manager, you can select which of the volumes to boot. Note that bootable
volumes exist only when Boot Manager is present; otherwise, the bootable
volume is designated as startable.

A bootable volume can be used to boot an operating system from Boot
Manager.

Installable
Installable is a volume designation, used by Logical Volume Manager during
installation, indicating that OS/2 Warp Server for e-business will be installed on
the volume. Only one volume can be set as installable.

Nonbootable

Nonbootable is a volume designation, used by Logical Volume Manager,
indicating that the volume contains nonbootable data rather than a bootable
operating system. For example, you might have an operating system installed
in one volume on your computer, and you might save your data in another
volume. To ensure that the system can be properly booted by the hardware,
you would designate the volume that contains the operating system as
bootable and designate the volume that contains your data as nonbootable.
Because some systems do not support booting beyond certain hard disk limits,
specifying a volume as nonbootable allows you to make use of those areas for
data.

A nonbootable volume cannot be used to boot an operating system from Boot
Manager.

Startable
Startable is a volume designation, used by Logical Volume Manager, indicating
the volume that is used when the computer starts. A startable volume must
contain either Boot Manager or a bootable operating system. For example, if
Boot Manager is installed, it is automatically set as the startable partition, and
the Boot Manager menu is displayed when the computer starts. If Boot
Manager is not installed, you must set, as startable, a volume that contains an
operating system. Then, when you turn on your computer, that operating
system will start automatically.

Only one volume or partition can be set startable.

A startable volume is the primary partition that is used to start the system, by
virtue of being the active partition.
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Volume Type Comparison

The following chart compares characteristics of compatibility volumes and LVM

volumes.

Table 2. Comparison of Compatibility Volumes and LVM Volumes

Characteristic

Compatibility Volume

LVM Volume

Can be set installable,
startable, or bootable

Yes

No

Maximum size

Size of disk device (the actual
usable size may be limited by
the intended file system)

2TB (terabytes)

Allowable file systems

386 HPFS, HPFS, FAT

JFS, 386 HPFS, HPFS, FAT

Can span multiple partitions
and disks

No

Yes

feature of 386 HPFS

Expandable No Yes, if formatted with JFS, or if
unformatted
Supports Fault Tolerance Yes No

Partition ID values (for more
information about this topic,
see Appendix B of Storage

X'06' (16-bit FAT > 32MB)

X'07’ (Installable File System)

x'35" (OS/2 Logical Volume
Manager)

Device Driver Reference for
0S/2, S71G-1897)

Disk Spanning

Disk spanning can be thought of as drive linking. It allows you to link multiple partitions
on multiple physical disks (hard disks) into a single, LVM volume. Disk spanning allows
you to create any size LVM volume by linking multiple physical disks together. The LVM
volume appears as one drive letter, compatible with all file operations presently used.

Dynamic Volume Expansion

Dynamic volume expansion allows you to increase the size of an LVM volume to
accommodate additional needed capacity without affecting the data already on the
volume. Expansion works only with JFS, not other file systems. The LVM volume
expands when you link additional partitions (which can be on the same physical disk or
on other physical disks). Additional space is always added to the end of the current
LVM volume space.

Dynamic Drive Lettering

Dynamic drive lettering allows you to manage drive letters on LVM volumes and
compatibility volumes without having to restart the system under most circumstances.
Previous OS/2 implementations statically allocated the number of drives at boot time,
forcing you to restart the system whenever you added or deleted drives.

Chapter 3. Preinstallation Planning 19



Persistent Drive Letters

After you to assign a drive letter to a new LVM volume or compatibility volume, that
drive letter will remain persistent until you explicitly change it or delete the volume. This
function prevents problems resulting from drive order changing with repartitioning or
adding new hardware.

For example, if you add a new hard disk and configure it as a new volume, you can
assign a drive letter later in the alphabetic sequence than the CD-ROM drive letter, thus
preventing the CD-ROM drive letter from changing. If you invoke the NET USE
command to access LAN drives, you can assign a letter to the new volume later in the
alphabetic sequence than any preferred LAN drive letters, even if the drive letters are
not in use at the time you run LVM.EXE or LVMGUI.CMD.

Note: Drive letters should not be changed where the operating system or any of its
components reside. If you change a drive letter on a volume that has files open,
you must restart the system after you exit LVM. Changing a drive letter may also
cause problems with applications that require LIBPATH entries or use hard
coded paths.

File System Descriptions

A file system is the software implementation of a method for managing user data on a
disk or other medium. It is the part of the operating system that provides access to data
and programs on a disk. Each type of Installable File System (IFS) has
implementation-specific details, such as directory formats and file layouts.

The following file systems are explained below:

Refer to LAppendix A_File System Comparisan Chart” an page 84 for a side-by-side

comparison of file system characteristics.

Journaled File System (JFS)

The Journaled File System (JFS) is a file system that uses database journaling
techniques, such as recording file changes sequentially, to maintain file system integrity.
JFS provides a high-performance, 32-bit file system implementation for the OS/2 Warp
Server for e-business environment. JFS is tailored primarily for the high throughput and
reliability requirements of servers from single processor systems to advanced
multiprocessor and clustered systems where performance and reliability are desired.
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JFS uses the proven technology of the existing AIX JFS implementation, and it is
enhanced to provide support for extended attributes, unicode names, and
case-insensitive searches. Also, a number of significant features are added to JFS to
make it more competitive and scalable, resulting in fundamental changes to the file
system layout. These features include extent-based allocation, sorted directories, and
dynamic space allocation for file system objects.

Additional features of JFS include:

* The ability to create and maintain volumes up to 2TB (terabytes) in size, in contrast
to the 386 HPFS and HPFS limit of 64GB and the FAT limit of 2GB.

» File sizes of up to 2TB, while 386 HPFS, HPFS, and FAT allow file sizes of 2GB.
» Compatibility with applications already using 386 HPFS and HPFS.
* Improved recovery time from system failures by using journaling techniques.

» Dynamic volume expansion in conjunction with LVM, resulting in improved file system
scalability compared to the other file systems.

Note: The Journaled File System can be used only on LVM volumes, and therefore is

not bootable. See E\alume Designations” an page 18 for more information about

bootable volumes.

Journaling Techniques

JFS provides improved structural consistency, recoverability, and much faster restart
times than current nonjournaled file systems, such as 386 HPFS, HPFS, FAT, and
traditional UNIX file systems. File systems are subject to corruption in the event of
system failure because a logical file operation takes multiple media reads and writes to
accomplish, and the operation may not be totally reflected on the media at any given
point in time. These other file systems rely on restart-time utilities, such as CHKDSK,
which examine all of a file system’s meta-data to detect and repair structural integrity
problems. This is a time-consuming and error-prone process which, in the worst case,
can lose or misplace data.

In contrast, JFS uses techniques originally developed for databases to log information
about operations performed on file system meta-data as atomic transactions. An atomic
transaction is one that allows a function to be completed or to return to its original state
if a power interruption or abnormal end occurs. In the event of a system failure, a file
system is restored to a consistent state by replaying the log and applying log records
for the appropriate transactions. The recovery time associated with this log-based
approach is much faster because the replay utility need only examine the log records
produced by recent file system activity, rather than examine all file system meta-data.

Variable Block Size

JFS supports block sizes of 512, 1024, 2048, and 4096 bytes on a per volume basis,
allowing you to optimize space utilization based upon your application environment.
Smaller block sizes reduce the amount of internal fragmentation within files and
directories, and they are more space efficient. However, small blocks can increase path
length because block allocation activities may occur more often than if a larger block
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size was used. The default block size is 4096 bytes because performance, rather than
space utilization, is generally the primary consideration for server systems.

Object Names

Unicode File Names and Directory Names:  JFS is enabled for National Language
Support (NLS) and will store and manipulate all file and directory names that it
manages as strings of unicode characters. This storage method guarantees that
directories are correctly sorted no matter which code page is used during a particular
file system session. Thus, JFS provides the performance benefits of sorted directories
while being enabled for full multinational access.

Case Sensitivity: JFS supports case for names in a fashion consistent with the HPFS
implementation. Names are stored and returned as received (case is preserved), but
case is ignored during directory searches.

Maximum File Name and Directory Name Length:  Like HPFS, JFS limits the length
of a file or directory name to 254 unicode characters. This satisfies the requirements of
existing OS/2 applications.

JFS supports path names of up to 260 characters in length. This limit is imposed by the
Installable File System Manager (IFSM).

Online File System Expansion

JFS supports the expansion of a mounted and actively accessed volume. Should a JFS
logical volume run out of space, you can increase the volume’s size without the
disruption of backing up the contents, reformatting the volume, and then restoring the
contents.

Online Free Space Defragmentation

JFS supports the defragmentation of free space in a mounted and actively accessed
volume with the DEFRAGFS utility. When a volume’s free space has become
fragmented, defragmenting the file system allows JFS to provide more 1/O-efficient disk
allocations and to avoid some out of space conditions.

Sparse and Dense File Support

JFS supports both sparse and dense files on a per volume basis. Sparse files and
dense files are read similarly, but they are written differently.

A successful read operation returns a block of data. If the block that is read has not
been written to, then JFS returns a block of zero-filled bytes (a buffer full of binary
zeros, or nulls). This is true for both sparse and dense files.

Sparse files allow data to be written to random locations within a file without allocating

previously unwritten intervening file blocks (blocks in the file that are placed before the
highest block written, but that have not been written to themselves). For example, if you
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create a file and it is written to block 100, then blocks 0 through 99 are considered
previously unwritten intervening file blocks until you explicitly write to them. If the file
system is formatted for sparse files, then 1 block is allocated.

With sparse files, the file size reported is the highest byte that has been written, but the
actual allocation of any given block in the file does not occur until a write operation is
performed on that block.

Sparse files are of interest to applications that require a large, logical space, but use
only a small subset of this space.

For dense files, disk resources are allocated to cover the file size. In the above
example, the first write (a block of data to block 100 in the file) causes 100 blocks of
disk space to be allocated to the file. In other words, if the system is formatted for
dense files, then 100 blocks are allocated.

Because OS/2 applications most commonly use dense files, a new volume is
designated for dense files by default.

High Performance File System (HPFS)

HPFS file name rules are more flexible than those of FAT, allowing you to create more
descriptive file names. HPFS allows file names of up to 254 characters. Spaces and
periods are also allowed.

HPFS has features that make it a better choice than FAT for larger volumes, up to
64GB. HPFS puts the directory at the seek center of the volume and is designed to
allocate contiguous space for files, thus helping to prevent disk fragmentation. Use
HPFS instead of FAT on larger volumes because the savings in disk space is dramatic.

386 High Performance File System (386 HPFS)

386 HPFS is a server-optimized variant of HPFS. It provides improved access to large
disk volumes, and it optimizes performance in a server environment where many files
are open simultaneously from clients.

You must install OS/2 Warp Server for e-business before you install 386 HPFS. 386
HPFS is available as a separate feature. For information about 386 HPFS, see the
README on the 386 HPFS Upgrade for OS/2 Warp Server for e-business CD.

FAT File System

The File Allocation Table (FAT) file system is a file system compatible with DOS. FAT
file systems have a file allocation table that keeps track of the files and their locations
on the hard disk. File names cannot exceed 8 characters, and the file name extension
cannot exceed 3 characters. A period is always required between the file name and the
extension. Spaces are not allowed, and fewer nonalphanumeric characters are allowed
compared to other file systems.
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Select the FAT file system if you intend to share data in the volume with a version of
DOS that is running independently of OS/2 Warp Server for e-business. For example, if
you occasionally need to start DOS from a diskette and access the data on a OS/2
Warp Server for e-business volume, that volume must be formatted for the FAT file
system. DOS uses the FAT file system and does not recognize files created by JFS,
386 HPFS, or HPFS. Although a copy of DOS running in native mode does not
recognize the other file systems, this is not true for DOS sessions that run under OS/2
Warp Server for e-business. If you plan to run your DOS programs in the DOS sessions
that are part of OS/2 Warp Server for e-business, you can format for any file system.
However, the programs running in these DOS sessions will not recognize the longer file
names supported by JFS, 386 HPFS, and HPFS.

Considerations for Sharing Files in a Multinational Environment

In today’s global business environment, there is a critical need for fast access to all files
within a directory, regardless of the language character set (code page) used to create
the file originally or the code page being used by the system at the time the search for
the file is conducted.

The concept of multinational sharing of files is that individual files may be created using
one code page (language character set) and accessed using a different code page.

In contrast to 386 HPFS, HPFS, and FAT, JFS stores all file and directory names in
unicode. This storage method guarantees that directories are correctly sorted no matter
which code page is used during a particular file system session. Thus, JFS provides the
performance benefits of sorted directories while being enabled for full multinational
access.

If HPFS files created using different code pages reside within a single directory, HPFS
may be unable to maintain the directories upon which its search algorithms depend.
When this problem arises, some files in such a directory may become inaccessible.

FAT file systems tolerate multinational access well because they do not maintain sorted

directories. However, the performance cost of unsorted directory structures prevents
FAT from being a viable alternative for most software environments.
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Chapter 4. Installing and Configuring the Server

This section provides guidance for installing OS/2 Warp Server for e-business on a
server or hard disk without any existing disk partitions or operating systems. Limited
guidance is available for installing OS/2 Warp Server for e-business on a system with
existing partitions or operating systems. Refer to Migrating to OS/2 Warp Server for
e-business, SG24-5135 for detailed information about migrating your existing system to
OS/2 Warp Server for e-business.

As you begin the server installation process, you will find that the online help screens
provide most of the guidance you need. You can view the help screens at any time
during the installation process by pressing F1. This section is intended to supplement
the help screens by providing additional conceptual information along with the
procedures.

The following tasks comprise the installation process:

1. L i ”
a. lSelecting the Installation Volume” an page 28
b. [Earmatting the Installation Volume” on page 32

The table below lists additional resources about installing OS/2 Warp Server for

e-business:

For information about Refer to

Installing to a system without existing

partitions or without an existing . i u

operating system

Installing to a system with existing [ - - — — ]

partitions or with an existing operating E oS = >4

system

Creating installation diskettes [LCreating Installation Diskettes” on page 73

Adding device drivers to the [Madifying the Installation Diskettes for New Hardware’|

installation diskettes m

Installing to a system with removable |tAppendix C_Partitioned Remavahle Medid

media Cansiderations” an page 949

Installing to a laptop system linstalling to a Laptop System” on page 93

Remote IPL Network Administrator Tasks

DCHP Boot Network Administrator Tasks

Migrating your system Migrating to OS/2 Warp Server for e-business,
5G24-5135

Installing using the CID method Migrating to OS/2 Warp Server for e-business,
5G24-5135
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For information about Refer to

hage 8d or Serviceability and Troubleshooting Guide or
README.TXT

Troubleshooting installation problems

Installing to a System with Existing Partitions or Operating Systems

On systems that already contain partitioned hard disks or existing operating systems,
selection options may be different, and additional steps may be necessary. Review the
following topics before installing OS/2 Warp Server for e-business to a system with
existing partitions or operating systems:

CHKINST System Checking Utility

The CHKINST utility (CHKINST.EXE) checks the system prior to installation to
determine what preparation is required and then reports the results.

Run the CHKINST utility before installing OS/2 Warp Server for e-business if you are
installing to a system with existing partitions or operating systems.

To run the CHKINST utility at a command prompt:
1. Place the OS/2 Warp Server for e-business CD in the CD-ROM drive.

2. Type e:\chkinst /t:s: /1l:c:\filename.log, where e:is your CD-ROM drive
letter, s: is the planned installation volume, and c:lfilename.log is the full path and
file name where CHKINST will create an output log file. CHKINST sends its results
to the display and to the specified file.

CHKINST performs the following system checks:

» Detects components in use that you must remove prior to installation if you choose
not to format the installation volume. Such components include LAN Distance, IBM
Peer, Local Security, and 386 HPFS access controls, if present.

* Detects components that are not supported by OS/2 Warp Server for e-business that
may cause the operating system to fail, and then issues a warning message stating
that the components will be removed. Such components include OpenDoc, AskPSP,
and TrueMode.

» Detects components that are not supported by OS/2 Warp Server for e-business that
will likely not cause any failures if they remain on the system, issues a warning
message, and reports the files that have a current replacement. No configuration file
information is migrated for these components. Such components include OS/2
Tutorial, IBM Works, and VoiceType.

* Logs each item found and includes a drive letter, if applicable.
See the Command Reference for additional examples about using the CHKINST utility.
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Note: Refer to Migrating to OS/2 Warp Server for e-business, SG24-5135 for detailed
information about using the CHKINST utility and how to remove certain
components when you are upgrading your system.

LVM Volume Conversion Utility (VCU)

The LVM Volume Conversion Utility (VCU) is executed during installation to convert
existing partitions into LVM compatibility volumes and to replace Boot Manager if it is
already installed. Under some conditions VCU may detect inconsistencies in your
current partitioning that are incompatible with LVM, and the installation will stop to ask if
you want to proceed. VCU may also make certain changes that require the system to
be restarted, and it will issue a message informing you to do so. For more information

about VCU messages, see 'VCU Has Detected Corrupt Partitions” on page 89.

For detailed migration information, see Migrating to OS/2 Warp Server for e-business,
SG24-5135.

Preparing the System

This phase of installation determines whether the target system meets the prerequisites
for installing the operating system. It also makes the volume selected for installing the
operating system bootable and prepares the hard disk for installation, formatting if
necessary. Necessary files are copied, and then the system is restarted.

A bootable CD is included with OS/2 Warp Server for e-business. You can use the
Server Pak Installation CD to start the system and begin the installation process.
Because some systems might require bootable diskettes instead of a bootable CD, you
can create installation diskettes to start the system and begin the installation process.

ee kCreating Installation Diskettes” on page 73 for instructions.

Starting the Installation with a CD

To begin the installation process:

1. Gather the OS/2 Warp Server for e-business Server Pak Installation CD and the
Server Pak CD.

2. Insert the Server Pak Installation CD into the CD-ROM drive.
Turn on or restart the system.

4. Follow the prompts on the screen as directed. For more information, refer to the
online help screens by pressing F1.

Starting the Installation with Diskettes

Note: You must create installation diskettes before following these steps. See FCreating

Installation Diskettes” on page 73 for instructions.

To begin the installation process:
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1. Gather the OS/2 Warp Server for e-business Installation Diskette, Diskette 1,
Diskette 2, and the Server Pak CD.

Insert the Installation Diskette into the diskette drive.
Insert the Server Pak CD into the CD-ROM drive.
Turn on or restart the system.

a M wnN

Follow the prompts on the screen as directed. For more information, refer to the
online help screens by pressing F1.

Selecting the Installation Volume

When the Installation Volume Selection  screen is displayed, you can choose to
accept the default volume or to specify a different volume.

At this time you might want to consider other changes in the volume configuration, even
if the default installation volume is acceptable. For example, you might decide to create
some data volumes or to assign a different drive letter to the CD-ROM device. New
volumes do not need to be formatted now, but creating them will establish drive letters.
If Boot Manager is not already installed, you might want to add it now.

If, for any reason you want to run the Logical Volume Management Tool now, select
Specify a different volume instead of Accept the default volume

* Select Accept the default volume if you want to install OS/2 Warp Server for

e-business on the volume that is displayed. See lAccepting the Default Installation

for information about accepting the default installation volume.

« Select Specify a different volume if you want to install OS/2 Warp Server for
e-business on a volume other than the one that is displayed. In addition, select this
option if you have multiple primary partitions set up on your hard disk, so you can
verify that the correct partition or volume is active. See LSetting the Installation
Molume with | ogical Volume Manager” on page 29 for information about setting the

installation volume.

If Boot Manager is not already installed and you want to install it now, select this
option. If you plan to keep your existing operating system on one volume and install
OS/2 Warp Server for e-business on a new volume, you must install Boot Manager.

For more information about installing Boot Manager, see Linstalling Roat Manager” an

Accepting the Default Installation Volume

If you choose to accept the default installation volume, OS/2 Warp Server for
e-business will be installed to the volume specified. Next, the Formatting the
Installation Volume screen is displayed. For help with formatting the installation

volume, see [Earmatting the Installation Volume” on page 32,
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Setting the Installation Volume with Logical Volume Manager

When compatibility volumes are modified, all data on those volumes is deleted. Be sure
to back up all existing data before you modify a volume. Press Enter to continue the
installation, or press F3 to exit the installation and back up your data.

A message indicating the minimum volume size for installation is displayed; however,
you should define the installation volume greater than the minimum, depending on
which components you plan to install. See [Hard Disk Space Requirements” on page 10
for information about hard disk space requirements for OS/2 Warp Server for
e-business. Press Enter to start the Logical Volume Management Tool.

The LVM logical view is displayed, showing any existing volumes. You can either create
a new volume to be the installation volume, or you can select an existing volume to be
the installation volume.

[iz]
]

LVHM.EXE 7] £ |[Fif

Logical VWolume Management Tool - Logical Wiew

Logical “olume Type Status File System Size (ME)

[ CoROM 1 ] ¥->1: Compatibility

Disk Partition Size (MEB) Disk Mame

FS=Physical “iew Enter=0ptions Tab=lkWindaow

Figure 2. The LVM logical view displays any existing volumes, including CD-ROM
drives.

If you wish to create a new volume to be the installation volume, see m

If the existing partition or volume on which you want to install the product is not set as

installable, see Selecting an Existing Volume to he the Installation Volume” on page 31

for instructions.

If you wish to create other volumes, such as LVM volumes to format for JFS, see

ICreating a Nonhootable Volume” on page 64, and then continue with installation.
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Note: Be sure to record the drive letters of any LVM volumes you create. You will need
to know the drive letters when you format the volume for JFS.

Creating a New Volume to be the Installation Volume: To create a new volume to
be the installation volume:

=

Press Enter to display the Options menu.

Highlight Create a new volume and press Enter.

Highlight Create a volume that can be made bootable  and press Enter.
Highlight a drive letter from the list and press Enter.

Type the new volume name in the space provided and press Enter twice.
Highlight a hard disk on which to create the volume and press Enter.
Highlight Allocate from free space and press Enter.

Highlight the free space block you want and press Enter.

© 0N gk obd

Enter a name for the partition that will be included in the new volume and press
Enter.

[EnY
©

Enter a size, in megabytes, for the partition and press Enter.
The new volume is displayed in the LVM logical view.

11. Highlight the volume you just created.

12. Press Enter to display the Options menu.

13. Highlight Set the volume installable and press Enter.

When a volume is set installable, the word installable is displayed in the Status
column.

14. Press F3 to exit LVM.
15. Highlight Save the changes and exit and press Enter.
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Figure 3. In the LVM logical view, press Enter to display the Options menu.

The disk partitioning is completed. If you are prompted to restart the system so that the
partitions and volumes can be recognized during installation, follow the prompts on the
screen to restart the system and continue installation.

After the system is restarted, follow the prompts until the Installation Volume
Selection screen is displayed. Make sure that the correct installation volume is
displayed, and then select Accept the default volume

After you have selected the installation volume, the Formatting the Installation
Volume screen is displayed. For help with formatting the installation volume, see

Selecting an Existing Volume to be the Installation Volume: When a volume is set
installable, the word installable is displayed in the Status column.

To select an existing volume to be the installation volume:

1. Select the volume that you want to set installable by using the arrow keys to
highlight it.

2. Press Enter to display the Options menu.
Highlight Set the volume installable and press Enter.

When a volume is set installable, the word installable is displayed in the Status
column.

Press F3 to exit LVM.
5. Highlight Save the changes and exit and press Enter.

The Installation Volume Selection  screen is displayed. Make sure that the correct
installation volume is displayed, and then select Accept the default volume
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After you have selected the installation volume, the Formatting the Installation
Volume screen is displayed. For help with formatting the installation volume, see

[0

Formatting the Installation Volume

The volumes on a hard disk must be formatted before data can be stored there. If the
volume on which you will install OS/2 Warp Server for e-business has already been
formatted by DOS or OS/2, it is not necessary to format it again, unless the volume is
too small to accommodate OS/2 Warp Server for e-business.

Formatting a hard disk erases all files that currently reside there. If you need the
existing files, be sure to back up the files before you format the volume.

Select one of the following three options to format the installation volume:

1. Do not format the volume . If you select this option, the volume is not formatted.
Instead, the program adds OS/2 Warp Server for e-business files to the files that
already exist on the volume. The existing files either remain intact or are replaced.

2. Perform a long format . If you select this option, the volume is formatted with the
file system that you will select. This option formats each sector on the volume to a
known state consistent with the file system you select. Generally, you should
perform a long format when you are formatting a volume for the first time, if you are
reformatting a volume with a different file system, or if you are installing an
operating system to the volume.

3. Perform a quick format . If you select this option, the volume is formatted with the
file system that you will select. This option formats only the boot sector and the
directory sectors on the volume to a known state. The remaining sectors are not
touched. Therefore, the old data still exists, but it is not visible. The existing data is
overwritten by the new files as they are allocated. Generally, you should perform a
quick format if you are reformatting a volume with the same file system.

If you select either Perform a long format or Perform a quick format , the Select the

File Séstem screen is displayed. For help on selecting the file system, see m

Selecting the File System

During this point of the installation process, the installation volume can be formatted to
use the High Performance File System (HPFS) or the File Allocation Table (FAT) file
system. It is recommended that you use HPFS for the installation volume.

The base operating system cannot be installed on a volume formatted for the Journaled
File System (JFS) because JFS volumes are not bootable. Some components,
however, can be installed to other volumes, and these volumes can generally be
formatted for JFS, HPFS, or FAT, unless restricted by the individual component. See

[Earmatting a Volume for a File System after Installation” on page 72 for information

about formatting a volume with a file system after installation.
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Select a file system for the installation volume:

1. High Performance File System (HPFS)
2. File Allocation Table (FAT) file system

If you want to format a volume with JFS during installation, see tEarmatting a \olume
for 1ES duri alation” =24,

After the volume is formatted, system files are copied from the Server Pak CD to the
server.

If you are using the Server Pak Installation CD, the system is automatically restarted,
and installation is continued.

If you are using installation diskettes, remove the diskette when prompted, and then
press Enter to restart the server and continue installation.

When the server is restarted, the System Configuration window is displayed. For help
about configuring hardware and software options, see L ] igur

Installing and Configuring Hardware and Software Options

This phase of installation collects information about the components of the system that
will be installed, and then allows you to select hardware and software options.

Installing and Configuring System Hardware

The System Configuration windows display the hardware and country choices
currently defined on the system. If the current choices are correct, click Next.
Otherwise, click the icon beside the choice you want to change.

The first System Configuration window allows you to install and configure the
following options:

e Locale

» Currently Installed Peripherals
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g4 System Configuration

If the following hardware and country choices are correct, select Next. To change a
choice, select the icon beside it.

~Locale
E Country % Keyboard
United States United States
-System
Mouse Primary Display

Serial Pointing Device

Serial Device Support

Support Installed

SVGA [ATI)

Secondary Display

Hone

~Currently Installed Peripherals

CD-ROM Device Support Printer

ﬁ%"] |Tushiha 5302B,56028 # %l |Nu printers attached |

Multimedia Device Support SCS| Adapter Support

r
@ [Sound Blaster AWE PnP = @ [OLogic QLAA00 Adapter =

Help I

Figure 4. The first System Configuration  window.

Country

Click Country to install support for a country other than the one listed. The country you
select is used to set the locale information, including date and time format, decimal
separator, currency symbol, and time zone. It is also used to determine which version of
WIN-OS/2 to install, such as Latin, Greek, Hebrew, Arabic, Thai, Turkey, or Central
European, for SBCS versions of OS/2 Warp Server for e-business.

The operating system uses the primary code page each time it starts, and it can switch
to the alternate code page when necessary. A code page contains the language
characters, letters, numbers, and symbols the computer uses to print or display
information in a particular language.
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If you select a country that uses the euro as its currency, you can click the Use Euro
Locale option, which makes the euro sign the currency symbol to use when displaying
monetary values.

See 0OS/2 Keyboards and Codepages in the Assistance Center folder after installation
for more information about keytop character assignments and code pages.

Keyboard

Click Keyboard if you want to install a keyboard layout other than the one listed. When
you select a keyboard, you indicate to the operating system the character to expect
when you press a key. The keytop character arrangement varies from country to
country.

See 0OS/2 Keyboards and Codepages for more information about keytop character
assignments and code pages.

Mouse

Click Mouse to install a mouse or pointing device other than the one listed.
Serial Device Support

Click Serial Device Support to add support for a device, such as a modem, serial

plotter, or serial printer, assigned to ports COM1, COM2, or COMS3. This option is not
required for mouse support.

Primary Display

Click Primary Display to install a primary display driver other than the one listed.
Secondary Display

Click Secondary Display to install a secondary display driver other than the one listed.
CD-ROM Device Support

Click CD-ROM Device Support to install support for a device other than the one listed.

Multimedia Device Support

Click Multimedia Device Support to install audio card drivers or to change the settings
for audio cards.

Printer

Click Printer to install support for a printer or plotter. If you have a printer attached to
your system, make sure that you select this option.
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You can select a printer after installation by using the Selective Install option. See
[ - I oo [ I ol
B-husiness” on page 69 for more information.

SCSI Adapter Support

Click SCSI Adapter Support to install support for an adapter other than the one listed.

If you are installing to a laptop system, see Linstalling to a | aptop System” an page 93

for device driver recommendations and considerations.

The second System Configuration window allows you to install configure the following
options:

o [ ”

q T ]
.

o I ”
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B4 System Configuration {cont.)

Figure 5. The second System Configuration  window.

Advanced Power Management

Click Advanced Power Management if you have a server that has Advanced Power
Management capabilities. During the initial installation of the operating system, this

option is installed if the installation program detects this capability. Otherwise, it is not
installed.

SCSI Il Optical Support

Click SCSI Il Optical Support to install support for SCSI Il Optical drives with 512-byte
sector optical media.

External Diskette Drive

Click External Diskette Drive to install support for an external diskette drive attached
to your laptop computer.

Chapter 4. Installing and Configuring the Server 37



PCMCIA Support

Click PCMCIA Support if you have a computer that has a Personal Computer Memory
Card International Association (PCMCIA) adapter. During the initial installation of the
operating system, this option is installed if the installation program detects such an
adapter. Otherwise, it is not installed.

UltraBay Device Swapping

Click UltraBay Device Swapping to install support for interchangeability of your
external diskette drive and CD-ROM UltraBay device on your IBM ThinkPad.

Selecting Features to Install

The OS/2 Warp Server for e-business Setup and Installation window displays which
features of the operating system that can be installed. You can also format volumes for
file systems, such as JFS. See tEarmatting a \Volume for JES during Installation” on

for instructions.

The check mark next to a feature means the feature is selected for installation. If you
do not want to install a feature, remove the check mark. If a feature has a More button
to its right, click More to see additional choices.

For example, if you want to install some of the font groups that come with the operating
system, make sure Fonts is selected. Then click More to see a list of font groups.
When the list is displayed, place check mark to the left of any font groups you want to
install.

The following operating system features are available to install:

o I ”
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B 0sf2 warp Server for e-business Setup and Installation
Options  Software configuration  Help

Make sure there is a check in the box next to the features you wish to
install. Select "More..."" to make additional choices for a feature.

[+ Assistance Center [1.74MB] .....occooeeiieieieiiee e
[ Fonts [150.10MB] ...cooonie e e e
i System Utilities [2.29MB] .....cccocoeeeieeeeeeeee e
[ System Components [1.07MB]
[_i Printer Utilities [10.79ME] ....

[_i Symmetric Multiprocessor Support [1.01MB] Disk Space (Drive D

Available:

Previous | Hext Help | Heeded:

Figure 6. The OS/2 Warp Server for e-business Setup and Installation window.
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Formatting a Volume for JFS during Installation

If you created an LVM volume earlier in the installation process, you can format it for
JFS during installation. Doing this will allow you to install some components to the JFS
volume. When the system displays the OS/2 Warp Server for e-business Setup and
Installation window after rebooting during the installation process, you can format the
volume.

To format an LVM volume for JFS:

1. From the OS/2 Warp Server for e-business Setup and Installation window,
choose Format from the Options pull-down menu.

2. Select the volume you want to format. (This is the drive letter of the LVM volume
you created earlier.)

3. Choose Format Disk from the Selected pull-down menu.
The Format Disk window is displayed.

4. Type a volume name in the Volume Label entry field.
Select a file system type of JFS.

6. Click on the Format button.
The Format Progress window is displayed.
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7. Click OK when the formatting is complete.
8. Close the Format Disk window.
The OS/2 Warp Server for e-business Setup and Installation window displays the

features of the operating system that can be installed. You can also format volumes
from this window by clicking Format from the Options pull-down menu.

Assistance Center

Click Assistance Center to install online books and other technical information on the
system. After installation, you can access the Assistance Center from the Desktop.

Fonts

0S/2 system fonts are automatically installed to the boot drive of OS/2 Warp Server for
e-business. These system fonts are either OS/2 bitmap or Adobe Type Manager (ATM)
fonts, and they contain the following character sets: Latin, Cyrillic, Hebrew, Greek, and

Arabic. The OS/2 bitmap fonts also contain the Thai character set. The following OS/2

system fonts are automatically installed:

0S/2 Bitmap Fonts ATM Fonts

Courier Courier

Helv Helvetica

System Monospace

System Proportional

System VIO

Tms Rmn Times New Roman

Warp Sans

Click Fonts to indicate which additional font groups you want to install on the system.
Select the volume where the additional font files will be installed. The fonts will be
installed to the \PSFONTS directory of the volume you select. The following font groups
are available:

e Unicode

e Japanese

» Simplified Chinese
» Traditional Chinese
* Korean

* Arabic legacy

* Greek legacy

e Thai

These additional fonts can be used on systems that function as print servers when you

want to print documents that contain these additional character sets. The Unicode fonts
are used to display all other characters that are outside the character sets of the
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system fonts. If the Unicode fonts or other additional fonts are not installed, Java,
Locale Settings, Netscape Navigator, and other applications that use these character
sets will not display the characters.

System Utilities

The following system utilities are available:

Backup Hard Disk:  This utility backs up one or more files from one disk to another.
Change File Attributes:  This utility displays the current file state. It is also used to
turn on or off the read-only attribute and the archive bit of selected files in a directory or
for all files in a directory level.

Display Directory Tree:  This utility displays all the directory paths found on a
specified drive. It also lists the files in the root directory and in each subdirectory.

Manage Partitions:  This utility creates or deletes a partition or logical drive or makes
a partition startable.

Label Diskettes:  This utility creates or changes the volume identification label on a
disk.

Link Object Modules:  This utility combines program modules together to create
executable programs.

Picture Viewer:  This utility prints or displays picture files.
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PMREXX: This utility provides you with a windowed environment for running REXX
programs and, by extension, any programs called by REXX. (REXX is a procedure
language that can be used to write batch procedures. You can also use REXX as a
macro language or as a traditional application programming language.)

Recover Files:  This utility retrieves files from a disk that contains defective sectors.

Restore Backed-up Files:  This utility copies one or more files that were previously
backed up from one disk to another.

Sort Filter:  This utility reads data from a standard input device (such as a keyboard),
sorts the data, and writes it to a standard output device (such as a screen).

Installation Utilities: ~ These utilities are required for response file (unattended or CID)
installation and by some installation programs.

Create Utility Diskettes:  Click Create Utility Diskettes to install a utility that creates
bootable base OS/2 utility diskettes, which can access compatibility and logical volumes
of all formats, such as JFS, 386 HPFS, HPFS, and FAT. These utility diskettes include
the three bootable diskettes (such as the ones included with the OS/2 Warp Server for
e-business product package) and a fourth diskette that contains some useful utilities for
troubleshooting and tools to aid in system recovery.

This option also installs a utility to create bootable base OS/2 diskettes for CID. See the
README.CID file for more information.

Serviceability and Diagnostic Aids: These utilities enable your system to gather
information that can be used to isolate and correct system problems.

System Components

The following system components are available with this option:

. |‘High Perfarmance File chtpm (HPESYI

« R ”
.

Security:  Click Security to install application programming interface (API) support for
security applications. With this support, the security applications that you buy or develop
can provide enhanced file, print, and process security.

High Performance File System (HPFS): If you have formatted a volume with HPFS
during installation, this option is required and cannot be deselected. Click High
Performance File System to install HPFS if you plan to use the HPFS file system later.

If you install HPFS, the installation program automatically sets up the HPFS cache and
adds an IFS statement to the CONFIG.SYS file.
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Journaled File System:  If you have formatted a volume with JFS during installation,
this option is required and cannot be deselected. Click Journaled File System to install
JFS if you plan to use the JFS file system later.

If you install JFS, the installation program automatically adds an IFS statement to the
CONFIG.SYS file.

Printer Utilities

Click Printer Utilities to install network printer utilities. The following printer utilities may
be installed:

e MarkVision for OS/2
* MarkNet Port Driver

You can select the drive letter for the MarkVision for OS/2 and MarkNet Port Driver
components.

Tools and Games

Click Tools and Games to install one or more of the tools and games on your system.
The following tools and games are available:

Enhanced Editor:  This tool allows you to create and edit multiple files.

Search and Scan Tool:  This tool allows you to search for files on your hard disk or to
find text inside files.

OpenGL 1.0 3D Graphics Library: ~ This option installs OpenGL, a precise, 3D
rendering application programming interface (API). OpenGL provides 3D graphics
support for technical and engineering applications, presentation graphics applications,
desktop publishing applications, and end users.

Optional Bitmaps:  Click Optional Bitmaps to have more selections available as
background pictures for the OS/2 Warp Server for e-business Desktop.

Solitaire-Klondike:  Click Solitaire-Klondike to install Klondike-style Solitaire.
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CPU Monitor:  Click CPU Monitor to install a tool that monitors the use of system
resources using a graph.

Chess: Click Chess to install a chess game.

Mahjongg Solitaire:  Click Mahjongg Solitaire to install a tile-matching game.

0S/2 DOS Support

Click OS/2 DOS Support to install one or more DOS session choices. Check the items
you wish to install:

DOS Protect Mode Interface (DPMI) and Virtual Extended Memory Support (VEMS) are
DOS enhancements that are used by WIN-OS/2. If you choose to install WIN-OS/2
support, these two options cannot be deselected.

DOS Protect Mode Interface:  Click DOS Protect Mode Interface if you want to run
DOS programs written to the DOS Protected Mode Interface (DPMI) specification.

Virtual Expanded Memory Management: Click Virtual Expanded Memory
Management if you want to run programs written to the Lotus/Intel/Microsoft Expanded
Memory Specification (LIM EMS). This specification allows for up to 32MB of expanded
memory.

Virtual Extended Memory Support: Click Virtual Extended Memory Support  if you
want to run programs written to the Lotus/Intel/Microsoft/AST Extended Memory
Specification (LIMA XMS). This specification allows for the accessing of High Memory
Area, Extended Memory Blocks, and Upper Memory Blocks.

WIN-OS/2 Support

Click WIN-OS/2 Support to install the WIN-OS/2 features you want. You can also
indicate the volume (drive letter) where the WIN-OS/2 support should reside. WIN-OS/2
support can reside in the same volume as OS/2, or it can be placed in another volume.

You can install the following WIN-OS/2 features:

« Destination drive. Select the volume where files required for WIN-OS/2 support
should be installed. The volume where you are installing WIN-OS/2 support must be
formatted.

* Readme files. Select this option if you want to install more information about
WIN-OS/2 support.

* Accessories. Select this option if you want to install the following WIN-OS/2
accessories:

— Calculator

44  0S/2 Warp Server for e-business: Quick Beginnings: Installing OS/2 Warp Server for e-business



— Calendar

— Cardfile

— Character Map
— Clock

— Media Player

— Notepad

— Object Packager
— Paint Brush

— Write

Click Help for a description of each accessory.
» Screen savers. Select this option if you want to install screen savers.

* Sound. Select this option if you have a sound card installed and you want to be able
to assign sounds to system events.

Click Automatic Configuration if you want the new WIN-OS/2 Desktop to look like
your existing WIN-OS/2 or Windows Desktop (if one is already installed). If you do not
already have a WIN-OS/2 or Windows Desktop installed on your system, this option
installs the standard WIN-OS/2 Desktop for you.

Click Advanced Configuration if you want to change the appearance of your
WIN-OS/2 Desktop. You can choose from the following options:

» Standard WIN-OS/2 Desktop (without any customized features)
» Copy your existing WIN-OS/2 Desktop
* Preserve your existing WIN-OS/2 Desktop

If you select WIN-OS/2 support, several TrueType fonts, such as Arial and Courier New,
will be automatically installed.

Multimedia Software Support

Click Multimedia Software Support to set the following options:

» Destination Drive. Select the volume where files required for Multimedia Software
Support should be installed.

* Base Multimedia Support. This option will install the OS/2 files that provide
multimedia capabilities to your system.

= Software Motion Video. This option will install support for viewing high-resolution
digital movies on your Desktop. You must have Base Multimedia Support installed in
order to use Software Motion Video.

Java Development

Click Java Development to include the Java features. Place a check mark next to each
Java feature you want to install.
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Note: The default installation volume for Java support is the lowest drive letter
formatted with either the HPFS or JFS file system. This drive letter may be
different than the OS/2 boot volume, which is the default volume for installing
most components.

Select the HPFS or JFS volume where files for Java support will be installed. Available
Java features include:

» Toolkit. Select this option to install the following:
— The javac compiler
— C header files and libraries for building platform-specific methods
— Debug versions of all executable files

» Toolkit Documentation.  Select this option to install the Toolkit documentation on
your system.

» |ICAT (Debugger) for OS/2 Java. Select this option to install the debugger feature on
your system.

« Samples. Select this option to install sample Java applets on your system.

0S/2 Java is the IBM OS/2 implementation of the Java technology from Sun
Microsystem, Inc.

Symmetric Multiprocessor (SMP) Support

Click Symmetric Multiprocessor (SMP) Support  to take advantage of the multiple
processors on your SMP server.

When you select this option, you might be prompted to enter the source drive and
directory of your manufacturer’s platform-specific driver (PSD) file. Enter the full path for
the PSD file, and then click Install . Click Cancel if you want to cancel installation of
SMP support.

Installing and Configuring Server Components

After you have selected the hardware and software options, the Installing OS/2 Warp
Server for e-business window is displayed. Click Next to continue installation of
hardware and software support and to configure the server.

The Information window is displayed, prompting you to enter your name, department,
and company. The information you enter here will be used during configuration to
establish default names for your user ID, server, and domain.

Click Next to begin the server component installation, which includes the following
tasks:

1. lnstalling Hardware and Software Support” on page 47

46  0OS/2 Warp Server for e-business: Quick Beginnings: Installing OS/2 Warp Server for e-business



During the installation process, you can choose whether or not to configure some items
now or later. The Configuration window has an index of services that can be
configured.

Installing Hardware and Software Support

You can install and configure some or all of the following services from the OS/2 Warp
Server for e-business Setup and Installation ~ window.

File and Print Sharing Services. Allows you to use or share directories, printers,
and serial devices across a LAN. Includes services such as Messenger, Netlogon,
and Neighborhood Browser Enabler (NBE). NBE enables the server to function within
its domain as a master browser for Windows clients. The master browser function
provides Windows NT, Windows 98, and Windows 95 clients with the ability to view
the domain’s LAN Server machines and their resources via the Network
Neighborhood object. This service is automatically installed when you select File and
Print Sharing Services . There is not an option to deselect this service. For
information about autostarting this service after installation, see

TCP/IP Services. Allows you to install functions so the server can distribute TCP/IP
configuration for client workstations.

Remote Access Services. Allows remote users to connect to the LAN.
Netscape Communicator. Allows you to access the Internet

Tivoli Management Agent. Allows a network administrator to manage hardware and
software from a central location.

Personally Safe 'n’ Sound (PSnS Backup and Recovery). Allows you to back up
files on your server.

Lightweight Directory Access Protocol (LDAP) Services Toolkit. Allows the
infrastructure to be built for clients, applications, and servers of multiple vendors to
access information in a single, directory database in a consistent manner.

Advanced Print Services. Converts print jobs into the type of data your printer
supports.
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Figure 7. The OS/2 Warp Server for e-business services Setup and Installation window.

File and Print Sharing Services

This component includes a number of file and print sharing services as described
below:

File and Print Sharing Services Installation/Configuration. Allows you to use or
share directories, printers, and serial devices across a LAN.

File and Print Sharing Administration.  Allows you to administer file and print
sharing for client workstations.

User Profile Management. Provides user ID validation and user and group
management facilities.

Generic Alerter Service. Generates alerts to report server problems over the
network.

Virtual DOS LAN API Support. Provides support for the LAN Server APIs in specific
DOS sessions and in emulated DOS sessions when using the current version of the
OS/2 program.

Network Messaging. Allows you to exchange messages with other users and
receive messages from resources, such as printers, finishing a print job.

Remote Boot Service for OS/2 Workstations (Remote IPL). Allows you to support
remote IPL of OS/2 workstations. If you select Remote IPL, you will need to run the
RIPLINST utility to complete the setup of Remote IPL.
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* Remote Boot Service for DOS Workstations (Remote IPL). Allows you to support
remote IPL of DOS workstations. If you select Remote IPL, you will need to run the
RIPLINST utility to complete the setup of Remote IPL.

* Uninterruptable Power Supply (UPS) Support. Provides protection against loss of
data during power failures. Upon power interruption, users with active sessions to the
affected server are notified of the impending shutdown, and then an orderly server
shutdown is performed.

» Migration Import Utility.  Provides the support to migrate a domain control database
(DCDB) from PC LAN Program Version 1.3 to the current version of LAN Server.

TCP/IP Services

This option enables the server to distribute TCP/IP configuration to client workstations.
For each service you install, you must configure it in the TCP/IP Services folder after
installation is completed.

Select the TCP/IP services items that you want to install:

» DHCP/DDNS Server Support. Automatically assigns TCP/IP addresses and
registers TCP/IP host names to the workstations attached to the LAN.

» Virtual Private Network (VPN) Support.  Allows remote users to establish secure
connections to their corporate intranets over the insecure Internet.

* Network File System (NFS) Support. Provides remote, transparent access to files
and file systems.

Remote Access Services

Remote Access Services, or PPP Server, a replacement for LAN Distance, includes a
remote access server that allows NetBIOS and point-to-point protocol (PPP) clients,
including Windows NT, Windows 98, Windows 95, IBM OS/2 Internet Dialer, and IBM
8235 users, to remotely access the LAN.

Netscape Communicator

Netscape Communicator lets you access and navigate the Internet with Netscape
Navigator, send and receive e-mail with Netscape Messenger, keep track of the latest
postings in your favorite newsgroups with Netscape Collabra, and create your own Web
pages with Netscape Composer. Some applications and services, such as those found
at IBM Software Choice, use the browser as a graphical user interface (GUI) for tasks
related to installing, uninstalling, or updating other software programs.

Tivoli Management Agent

The Tivoli Management Agent (TMA) extends the server/client hierarchy and enhances
the scalability of a Tivoli Management Environment. Tivoli is a systems management
tool for enterprise-wide, heterogeneous networks. The TMA increases the number of
resources that can be managed and, at the same time, enables those resources to be
used more efficiently.
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PSnS Backup and Recovery

Personally Safe 'n’ Sound (PSnS Backup and Recovery) allows you to safeguard your
system against possible loss of information by taking backups of your OS/2 files and
folders. The software allows for automatic or manual file backup, and you can
selectively restore files. You designate how your backups are stored, and the software
manages backup and retrieval for you. Diskette drive support is automatically included.
The following devices are available for backup:

» Optical Drive Support

e LAN Drive Support

e SCSI Tape Drive Support

* ADSM Device Support

» Partitioned Removable Media Support
* Remote Drive Support

Lightweight Directory Access Protocol (LDAP) Toolkit

The LDAP Toolkit allows the infrastructure to be built for clients, applications, and
servers of multiple vendors to access information in a single, directory database in a
consistent manner.

The following components are part of the LDAP Toolkit:

+ LDAP Toolkit. Select this item if you want to install the header files (.h) and libraries
needed to develop an LDAP application.

« LDAP Examples. Select this item if you want to install the source for the sample
LDAP programs, the header files, and the makefile.

« LDAP Documentation. Select this item if you want to install the LDAP Programming
Reference (.htm files). After installing, load progref.htm with your Web browser to
access the programming reference.

* JAVA/INDI Support. Select this item if you want to install the JAVA/JNDI support.

* JAVA Documentation. Select this item if you want to install the JAVA/IJNDI
documentation.

Advanced Print Services

Advanced Print Services allows you to choose how printers are attached to your server,
and increases your printing capability by automatically performing data stream
transformations to convert the data in a document into the type of data required by the
printer. This enables you to print formats that are typically not supported by the printer,
such as converting PostScript files to print on non-PostScript printers.

Configuring the Server before Installation

Note: Do not click Install until you have finished configuring all the items that you want
to install.
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The Configuration window contains two sections:

The section on the left side of the window contains a list of items that you can
configure. A green check mark next to an item means that the item is correctly
configured; a red arrow means that the item must be configured; and a blue box
means that the item is configured correctly with the default value.

The section on the right side of the window is the area in which you configure the
currently selected item from the list on the left side of the window. In the list, click the
item that you want to configure. Select and configure one item at a time.

For information about configuration options for each item, click Help.
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Figure 8. The Configuration window lets you configure the services you want to install.

To configure items:

1.

Click the item to configure.
The corresponding page for that item opens on the right side of the window.
Make your configuration choices for the item.

When you are finished configuring the first item, click another item from the list to
open its corresponding configuration page.

Continue selecting and configuring items until you have configured all the items that
you want to install.
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5. When you have finished configuring all the items that you want, click Install to
accept the configuration choices and continue installation.

Necessary files are copied from the Server Pak CD to the server. The system is

restarted automatically, and installation and configuration continues. The system is
restarted automatically for a final time.

Registering OS/2 Warp Server for e-business

After the system is restarted for the final time during installation, the Software
Registration window is displayed. You can choose to register the product now or later.
If you choose to register the product later, you can open the System Registration icon
on the Desktop and complete the registration form as instructed.
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Chapter 5. Creating and Managing Volumes and Hard Disk Partitions

The Logical Volume Manager (LVM) allows you to create and manage partitions and
volumes on the hard disks in your system. LVM components are initially installed and
configured during the OS/2 Warp Server for e-business installation process. After you
install OS/2 Warp Server for e-business, you can use LVM to perform additional volume
management tasks.

This section describes how to use the text mode window interface of the Logical
Volume Management Tool (LVM.EXE).

To start LVM:
1. Open an OS/2 window.
2. Type lvm and press Enter.

LVM provides both logical and physical views of the system. The logical view displays
the volumes currently configured on the system. The physical view shows how the hard
disks are partitioned, including free space. Switch between the two views by pressing
F5.

Note: Previous versions of OS/2, such as OS/2 Warp 4, cannot recognize volumes, but
they do recognize partitions. Therefore, you might notice drive letter
discrepancies between previous versions of OS/2 and OS/2 Warp Server for
e-business. You can use LVM with OS/2 Warp 4; however, you must use only
the LVM physical view to manage partitions.

The following LVM files are necessary if you plan to use LVM on OS/2 Warp 4:

Tvm.exe (o0s2 directory)
Tvm.d11 (d11 directory)
Tvm.msg (system directory)
Tvmh.msg (system directory)

Managing Volumes with the LVM Logical View

The LVM logical view displays the volumes currently configured on the system. You can
use this view to create and manage volumes on your system and to specify Boot
Manager support options. Boot Manager is a utility that allows you to have multiple
operating systems on a system. The Boot Manager menu displays when you start the
system, allowing you to choose which operating system to use.

The logical view is divided into two windows. Press Tab to move the highlight selector
between the two windows.

The upper window displays the volumes currently in use. This window is used to create,
delete, hide, name, and expand volumes, plus specify Boot Manager support options.
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The lower window displays partition information for the volume you have highlighted in
the upper window. Operations on a highlighted partition can be performed without
switching to the physical view.

The LVM logical view displays the volumes currently configured on the system,
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Figure 9. The LVM logical view displays the volumes currently configured on the
system.

including volumes on hard disks, network drives, CD-ROM drives, and partitioned
removable media.

Other information in the upper logical view window includes:

Logical Volume
The name that has been assigned to the volume. A volume consists of one or
more partitions. It is assigned a drive letter and is treated as if it were a single,
contiguous partition. You can specify the name when you create a volume with
the Create a new volume option, or you can change the name with the
Change the volume name option.

Drive Letter Preferences
The new drive letter assignments until you exit LVM and save the changes.
Drive letter preferences are displayed to the left of the assigned drive letters.
An asterisk (*) indicates that no drive letter preference has been assigned.

Current Drive Letter Assignments
The drive letter assignments to which the volumes are currently assigned.
Assigned drive letters are displayed to the left of the Type column.

Temporary Volumes for Non-LVM Devices
LVM displays temporary volumes to represent non-LVM devices, such as
CD-ROM drives and network drives, which have drive letters assigned to them.
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Drive Letter Conflicts
LVM displays drive letter conflicts or discrepancies in the logical view as
follows:

X:->Y:, where X is the drive letter preference of the volume, and Y is the drive
letter to which the volume is currently assigned. This notation is displayed only
if the two drive letters, X and Y, are different.

Type Two types of volumes are possible with LVM: Compatibility volumes and LVM
volumes.

» Compatibility volumes created by LVM can be marked bootable or startable,
are accessible by other operating systems, and can be formatted for 386
HPFS, HPFS, or FAT. The OS/2 base operating system must be installed on
a compatibility volume.

e [ VM volumes can be formatted for JFS, 386 HPFS, HPFS, or FAT, and can
link multiple partitions into a single volume. LVM volumes can be accessed
only by OS/2 versions that contain LVM.

Status A volume designation indicating if a volume is startable, bootable, or
installable. See L i ions” for more information.

» If set Startable, the respective volume is used to start the system. If any
volume other than the Boot Manager partition is set startable, no volume is
displayed as bootable, and Boot Manager does not run. Boot Manager is
typically set as the startable partition, but it does not display in the logical
view.

 If set Bootable, the respective volume is displayed on the Boot Manager
menu when the system is started. LVM volumes cannot be bootable.

 If set Installable, the respective volume is designated as the target for
installing OS/2 Warp Server for e-business. The installable designation is
displayed and set only during installation, and it implies that the installable
volume is also bootable or startable, depending on whether or not Boot
Manager is installed. If Boot Manager is installed, the volume that is set
installable is also bootable. If Boot Manager is not installed, the volume that
is set installable is also startable.

File System
Indicates the type of file system used on the volume. Any volumes that have
not been formatted have a file system type indicated as None.

Size Indicates the size, in megabytes (MB), of the volume.

To modify a volume setup, highlight the volume, and then press Enter to display the
Options menu. You can perform the following tasks in the logical volume view:
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Expanding a Volume

Use Expand the volume to expand an LVM volume. You may expand a volume if the
volume does not have a file system associated with it (if it is unformatted) or if the
volume has the JFS file system associated with it. If file systems other than JFS are
associated with the volume you want to expand, you must first delete the volume, and
then re-create it.

To expand a volume:

1. Select an LVM volume to be expanded by using the arrow keys to highlight it.
Press Enter to display the Options menu.
Highlight Expand the volume and press Enter.
Read the instructions for choosing a disk and press Enter to continue.
Highlight a disk and press Enter.

A window is displayed, allowing you to specify information about the volume you
want to expand.

ok wb

6. Highlight your choice of Use existing partition or Allocate from free space and
press Enter.

7. Highlight a partition or free space block from the list and press Enter.
Type a name for the partition and press Enter.

9. If a window is displayed instructing you to specify a partition size, type a partition
size value and press Enter.

10. If you want to add more partitions to the LVM volume, go back to step 5 for
additional disk selection.

11. If you are finished adding partitions to the LVM volume, press F6 to end the
partition selection and to activate your choices.

12. Press F3 to exit LVM.
13. Highlight Save the changes and exit and press Enter.

When the changes are saved, the system attempts to expand the volume without
restarting; however, if other LVM operations are performed during the same LVM
session, the system might need to be restarted to make the changes effective. You are
prompted when a restart is required.
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Deleting a Volume

Use Delete the volume to delete an existing volume. All partition structures associated
with the volume will be removed from the associated hard disks.

To delete a volume:

Select the volume you want to delete by using the arrow keys to highlight it.
Press Enter to display the Options menu.

Highlight Delete the volume and press Enter.

Confirm that this is the correct volume to delete and press Enter.

Highlight Delete the volume and press Enter.

Press F3 to exit LVM.

Highlight Save the changes and exit and press Enter.

N o g~ oD

When the changes are saved, the system attempts to delete the volume without
restarting; however, if the file system cannot be unmounted, the system needs to be
restarted to make the changes effective. You are prompted when a restart is required.

Hiding a Volume from OS/2

Use Hide the volume from OS/2 to remove a drive letter and make a volume invisible
to OS/2. Use this choice to block access to a volume by the file system. For example, if
you have a Windows volume, you might not want to access it from OS/2. Therefore,
you would need to hide the volume. A volume that is hidden is no longer accessible by
0S/2, but all the associated data still exists on the hard disk.

To hide a volume from OS/2:
1. Select the volume you want to hide by using the arrow keys to highlight it.
2. Press Enter to display the Options menu.
3. Highlight Hide the volume from OS/2 and press Enter.
The drive letter is no longer displayed.
4. Press F3 to exit LVM.
5. Highlight Save the changes and exit and press Enter.

Note: Use Change the volume drive letter to make the volume visible to OS/2 again.
When the changes are saved, the system attempts to hide the volume without

restarting; however, if the file system cannot be unmounted, the system needs to be
restarted to make the changes effective. You are prompted when a restart is required.

Changing a Volume Name
Use Change the volume name to set or change the name of a volume. The volume

name on the Boot Manager Startup menu is also changed, if applicable. The names
you assign to volumes remain unchanged through restarting and hardware changes,
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and they always identify the same area on the disk. Volume names can be up to 20
characters long, can be entered in mixed case, and can contain spaces.

To set or change a volume name:

1. Select the volume you want to change by using the arrow keys to highlight it.
2. Press Enter to display the Options menu.

3. Highlight Change the volume name and press Enter.

4

Type the volume name in the space provided and press Enter. The new volume
name is now displayed.

Press F3 to exit LVM.
6. Highlight Save the changes and exit and press Enter.

Changing a Drive Letter Assigned to a Volume

Use Change the volume drive letter to change the drive letter associated with an
existing volume, or to make the volume visible to OS/2 after you have hidden it using
Hide the volume from OS/2 . The new drive letter association remains unchanged until
you change the drive letter again or delete the volume.

Note: Changing the drive letter assigned to a volume can have unforeseen effects. The
drive letter currently assigned to the volume must not appear in any PATH,
DPATH, or LIBPATH statements in your CONFIG.SYS file. Furthermore, the
drive letter should not be referenced in any of the .INI files on the system. If
these conditions are not met, your system might not start properly, and some
programs might not run correctly.

To change the drive letter assigned to a volume:

1. Select the volume you want to change by using the arrow keys to highlight it.
Press Enter to display the Options menu.

Highlight Change the volume drive letter and press Enter.

Read the warning message that is displayed, and then press Enter to continue.

a > wDn

Highlight the new drive letter and press Enter.

The new drive letter is displayed.

Press F3 to exit LVM.

Highlight Save the changes and exit and press Enter.

When the changes are saved, the system attempts to change the drive letter
assignment without restarting; however, if the file system cannot be unmounted, or if the
drive letter conflicts with one that is already in use by a non-LVM device, the system
needs to be restarted to make the changes effective. You are prompted when a restart
is required.

When you assign a new drive letter to a volume, LVM indicates which drive letters
belong to non-LVM devices in the drive letter selection window:

>X<, where X is the drive letter.
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This notation indicates that you can select this drive letter for the volume you are
reassigning, but you will also need to restart the system after you exit LVM.

Setting a Volume Installable

A volume can be set installable only during installation of OS/2 Warp Server for
e-business.

See [Setting the Installation Volume with | ogical Volume Manager” on page 29.

Setting a Volume Startable

Use Set the volume startable to set the selected volume startable. A startable volume
is the volume (or partition) that is used to start the system from a hard disk. It is the
active partition. Only a compatibility volume on a primary partition can be set startable
with LVM. Boot Manager, if it is installed, is automatically set as the startable partition.
Only one partition can be set as startable; therefore, if Boot Manager is to be active, no
volumes can be set as startable. If you set a volume as startable with LVM, Boot
Manager is disabled. Note that Boot Manager cannot be seen from the LVM logical
view because no drive letter is assigned to it, but it can be seen in the LVM physical
Vview.

To set a volume startable:

1. Select the volume that you want to set startable by using the arrow keys to highlight
it.

2. Press Enter to display the Options menu.
Highlight Set the volume startable and press Enter.

When a volume is set startable, the word startable is displayed in the Status
column.

4. Press F3 to exit LVM.
5. Highlight Save the changes and exit and press Enter.

Adding a Volume to the Boot Manager Menu

Use Add the volume to Boot Manager to add a volume to the Boot Manager Startup
menu. Only volumes that are bootable are displayed on the list. Choose this option if
you have more than one operating system that you wish to access when your system
starts. For example, if you have a previous version of OS/2 Warp Server on one volume
and OS/2 Warp Server for e-business on another volume, you might want both volumes
to display on the Boot Manager Startup menu. Doing this allows you to start the system
with either version of OS/2 Warp Server.

Note: When you create a bootable volume, it is automatically added to the Boot
Manager Startup menu.

To add the volume to the Boot Manager Startup menu:
1. Select the volume to be added by using the arrow keys to highlight it.
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2. Press Enter to display the Options menu.
3. Highlight Add the volume to Boot Manager menu  and press Enter.

The status of the volume is now Bootable.

Removing a Volume from the Boot Manager Menu

Use Remove the volume from Boot Manager to remove a volume from being
displayed on the Boot Manager Startup menu.

To remove a volume from the Boot Manager Startup menu:

1. Select the volume to be removed by using the arrow keys to highlight it.
2. Press Enter to display the Options menu.

3. Highlight Remove the volume from Boot Manager and press Enter.

The word Bootable is no longer displayed in the Status column.
Creating a New Volume

Use Create a new volume to create a volume on one or more selected hard disks. You
can create bootable or nonbootable volumes. If you are creating an installation volume
for OS/2 Warp Server for e-business, you must create a bootable volume.

If you want to keep your existing C: drive available with its own operating system, and
then set up D: as the target compatibility volume for installing OS/2 Warp Server for
e-business, you must first install Boot Manager. Only one volume is bootable unless

Boot Manager is installed. See Elnstalling Boat Manager” an page 63 for instructions.
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Figure 10. Use the LVM logical view to create a volume.
Creating a Bootable Volume

Use Create a volume that can be made bootable to create a bootable volume. A
bootable volume is a volume that can be used to boot an operating system from Boot
Manager. When you create a bootable volume, it is automatically added to the Boot
Manager Startup menu. A volume created as bootable is a compatibility volume. Create
a nonbootable volume when you want an LVM volume or when you want to use the
Journaled File System (JFS).

To create a volume that can be made bootable:

1. Press Enter to display the Options menu.
Highlight Create a new volume and press Enter.
Highlight Create a volume that can be made bootable  and press Enter.
Highlight a drive letter in the list and press Enter.
Type the new volume name in the space provided and press Enter twice.
Highlight a hard disk on which to create the volume and press Enter.
Highlight Allocate from free space and press Enter.
Highlight the free space block you want and press Enter.
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Enter a name for the partition that is included in the new volume and press Enter.
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©

Enter a size, in megabytes, for the partition and press Enter.
The new volume is displayed in the LVM logical view.

Press F3 to exit LVM.

Highlight Save the changes and exit and press Enter.

PR
N
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Changes are effective when you save the changes and exit LVM. The system attempts
to add the new volume without restarting; however, under some circumstances, the
system needs to be restarted to make the changes effective. You are prompted when a
restart is required.

When you create a volume, LVM indicates which drive letters belong to non-LVM
devices in the following format:

>X<, where X is the drive letter.

This notation indicates that you can select this drive letter for the volume you are
creating, but you will also need to restart the system after you exit LVM.

Creating a Nonbootable Volume

Use Create a volume that does not need to be bootable  to create a nonbootable
volume. A nonbootable volume is a volume that is not used to boot an operating
system. Create a nonbootable volume when you want to create an LVM volume or to
use the Journaled File System (JFS). Nonbootable volumes usually contain data (not
operating systems); however, you can install certain components of OS/2 Warp Server
for e-business to a nonbootable volume.

Note: Nonbootable volumes can be either compatibility volumes or LVM volumes. LVM
volumes cannot be set as installable, bootable, or startable.

To create a volume that is not bootable:
1. Press Enter to display the Options menu.
2. Highlight Create a new volume and press Enter.
3. Highlight Create a volume that does not need to be bootable  and press Enter.
4

Highlight Create a compatibility volume  and press Enter if you want the volume
to be accessed by other operating systems or previous versions of OS/2, or
highlight Create an LVM volume and press Enter if you want the volume to span
multiple partitions or if you want to format the volume for JFS.

5. Highlight a drive letter in the list and press Enter.
Type the new volume name in the space provided and press Enter.

7. Read the instructions for selecting a disk and using F6, and then press Enter to
continue.

8. Highlight the hard disk on which to create the volume and press Enter.

9. Highlight Allocate from free space and press Enter.
10. Highlight which free space block to use and press Enter.
11. Enter a name for the partition that is included in the new volume and press Enter.
12. Enter a size, in megabytes, for the partition and press Enter.

13. If you are creating an LVM volume, either go back to step 8 to add another
partition to the volume, or press F6 to indicate that partition selection is complete.

14. Press F3 to exit LVM.
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15. Highlight Save the changes and exit and press Enter.

Changes are effective when you save the changes and exit LVM. The system attempts
to add the new volume without restarting; however, under some circumstances, the
system needs to be restarted to make the changes effective. You are prompted when a
restart is required.

When you create a volume, LVM indicates which drive letters belong to non-LVM
devices in the following format:

>X<, where X is the drive letter.

This notation indicates that you can select this drive letter for the volume you are
creating, but you will also need to restart the system after you exit LVM.

Installing Boot Manager

Use Install Boot Manager to install Boot Manager on the system. Boot Manager allows
you to specify which volume to boot from and allows you to set or change the Boot
Manager options. Boot Manager is automatically set as the startable partition at the
time it is installed. Only one partition can be set as startable; therefore, if Boot Manager
is installed, no volumes have a status of startable. Note that Boot Manager cannot be
seen from the LVM logical view because no drive letter is assigned to it, but it can be
seen in the LVM physical view.

Boot Manager is installed as a new primary partition at the beginning of the first free
space block where a new primary partition is allowed. This partition is the smallest size
allowed (1 cylinder), typically between 1MB and 10MB, depending on the size of the
hard disk.

To install Boot Manager:
1. Press Enter to display the Options menu.
2. Highlight Install Boot Manager and press Enter.

Boot Manager is now installed.
Removing Boot Manager
Use Remove Boot Manager to remove Boot Manager from the system.

To remove Boot Manager:
1. Press Enter to display the Options menu.
2. Highlight Remove Boot Manager and press Enter.

Boot Manager is now removed from the system. You must now set a volume as

startable for the system to boot from the hard disk. See L'Setting a Volume Startable” on
hage 4.
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Setting or Changing Boot Manager Startup Values

Use Set Boot Manager startup values to set the default boot volume, set the timer
inactive, change the timeout value, and change the display mode.

For Boot Manager support, the Boot Manager partition must be set as startable. To
deactivate Boot Manager support without deleting its partition or any of the environment
information, set a volume as startable using the procedure described in

To set or change Boot Manager startup values:

1.

If you want to change the default boot selection, select the volume by using the
arrow keys to highlight it.

Press Enter to display the Options menu.

Highlight Set Boot Manager startup values and press Enter.

A window is displayed, allowing you to specify Boot Manager options.

Default boot selection allows you to choose the default boot volume that boots
automatically each time you start the system, unless you select another volume
from the Boot Manager menu during the timeout period.

The currently configured default boot volume is displayed when the Boot
Manager Options window is opened. Press Enter to change the default boot
volume to the volume you selected before opening Set Boot Manager startup
values .

For Timer active , you can select Yes or No. Toggle between Yes and No by
pressing Enter. Select Yes when you want the default volume to boot
automatically after the timeout period. Select No to specify that the Startup menu
is to remain displayed until a selection is made.

For Time-out value , highlight the Time-out value choice on the Startup Values
menu, and then press Enter to display the Startup Timeout window. Enter the
number of seconds you want the Boot Manager menu to be displayed before the
default volume is booted automatically. Press Enter to activate your entry and
display it as the timeout value in the Startup Values menu.

Note: This value is active only when Timer active is Yes.

For Display mode , you can choose either Advanced or Normal to indicate the
amount of information to be displayed on the Boot Manager menu. Normal Mode
displays only the names of the volumes on the Startup menu. Advanced mode
gives more information about the volumes on the Startup menu. This information
includes disk number, drive letter, type of partition, volume size, file system type,
and accessibility, if hidden.

Make your selections for the startup options and select Save the changes .
Press Enter to save the changes, or press Esc to cancel.
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Managing Partitions with the LVM Physical View

The LVM physical view displays the partitions present on each hard disk, allowing you
to create and manage individual partitions. You can create partitions for other operating
systems that do not recognize LVM volumes or linked volumes. You can also create a
partition of a specific size and allocate it from the beginning or end or free space.

Note: After volumes have been created with LVM, FDISK should no longer be used to
manage partitions.

Note: Partitions do not have drive letters associated with them. You must create a

volume to assign a drive letter. See ECreating a New Volume” aon page 64 for

instructions on creating a volume.

This view has two windows to show how the disks are partitioned. Press Tab to move
the highlight selector between the two windows.

The upper window displays the physical disks in the system, allowing you to change the
name of a disk.

The lower window displays partition information for a disk you have selected, allowing
you to create a new partition, delete a partition, rename a partition, and change the
name of the volume containing a partition.

LVM.EXE 2| el |E]
Logical Yolume Management Tool - Physical Yiew
Physical Disk Size (MB) Free Space: Total Largest
1 [
2 [ D2 ] 1033 55 S1
3 Datal Disk Z16 115 115
4 [ D4 ] 1021 o o]
5 [ b5 ] 95 96 96
Disk Partition Size (ME} Type Status Logical “Wolume
[ BOOT MAMAGER ] 8  Primary In use
[ A1 ] 308 Primary In use C: LWM Compatible
[ A2 1] 21 Logical In use 05/2 Warp 3.0
FS=Logical “iew Enter=Options Tab=Window

Figure 11. The LVM physical view displays the current partitions and allows to you
manage them.

Other information in the upper window of the physical view includes:
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Physical disk
The disk number and name that have been assigned to the hard disk.

Size Indicates the size, in megabytes (MB), of the disk.

Total free space
Indicates the amount of space on a physical disk that is currently not allocated
to a partition.

Largest free space
Indicates the largest contiguous piece of free space that can be used to create
a partition.

To modify a disk setup, highlight the disk, and then press Enter to display the Options
menu. You can perform the following tasks in the upper window of the physical view:

. E . . 3

Other information in the lower window of the physical view includes:

Disk partition
Indicates the name of each existing partition or free space.

Size Indicates the size, in megabytes (MB), of the partition or free space.
Type Indicates the partition type, either Primary or Logical.

Status Indicates the availability status of the partition, either In use or Available.
Logical volume

Indicates the name of the volume, if any, which includes the partition.

To modify a partition setup, highlight the partition or free space, and then press Enter to
display the Options menu. You can perform the following tasks from the lower window
of the physical view:

Note: If you highlight the BOOT MANAGER patrtition, the Options menu is not
displayed, and none of the above functions can be performed. All functions for
Boot Manager are performed in the LVM logical view.

Changing the Disk Name
Use Change the disk name to change the name of the disk.

To change the disk name:

1. Select the disk whose name you want to change by using the arrow keys to
highlight it.
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2. Press Enter to display the Options menu.
3. Highlight Change the disk name and press Enter.
4. Type a new name for the disk in the space provided and press Enter.

The new name is now displayed.

Creating a New Partition

Use Create a new partition to create a new partition using all or part of a free space
block.

To create a new partition:

Press Enter to display the Options menu.
Highlight Create a new partition and press Enter.
Highlight Logical Partition or Primary Partition and press Enter.

Highlight Create at the end of free space or Create at the beginning of free
space and press Enter.
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Type a name for the partition and press Enter.
7. Type a size for the partition and press Enter.

Deleting an Existing Partition

Select the free space block you want to use by using the arrow keys to highlight it.

Use Delete the partition to delete an existing partition. This procedure is allowed only
if the partition status is Available. If the status is In use, then the entire volume must be

deleted from the LVM logical view.

To delete a partition:

Select the existing partition to delete by using the arrow keys to highlight it.
Press Enter to display the Options menu.

Highlight Delete the partition and press Enter.

Confirm that this is the correct partition to delete and press Enter.

Highlight Delete the partition and press Enter.

gk wdeE

Changing the Partition Name

Use Change the partition name to rename an existing partition.
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Figure 12. Use the LVM physical view to rename a partition.

To rename an existing partition:

1. Select the existing partition to rename by using the arrow keys to highlight it.
2. Press Enter to display the Options menu.

3. Highlight Change the partition name and press Enter.

4. Type a new name for the partition in the space provided and press Enter.

Changing the Volume Name

Use Change the volume name to rename the volume associated with an existing
partition.

To change the volume name:

1. Select the existing partition associated with the volume by using the arrow keys to
highlight it.

2. Press Enter to display the Options menu.
Highlight Change the volume name and press Enter.
4. Type a new name for the volume in the space provided and press Enter.
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Chapter 6. Additional Installation and Configuration Options

After you install OS/2 Warp Server for e-business, you might need to perform additional
installation and configuration tasks, depending on your system. Review this section to
determine which additional tasks you might need to perform. The following tasks are
discussed in this section:

Changing Hardware and Software Support after Installing OS/2 Warp Server for
e-business

You can add support for a device or change existing support after installing OS/2 Warp
Server for e-business:

From the OS/2 Warp Server for e-business Desktop, open OS/2 System .
Open System Setup .

w N e

Open Install/Remove .
Open Selective Install .

>
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Changing Support for Server Components after Installing OS/2 Warp Server for

e-business

You can add support for a device or change existing support after installing OS/2 Warp
Server for e-business:

1.
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From the OS/2 Warp Server for e-business Desktop, open OS/2 System .
Insert the Server Pak CD into the CD-ROM drive.

Open System Setup .

Open Install/Remove .

Open Selective Install for Networking

Creating a Volume for Receiving Memory Dumps

If your system traps or hangs, you might be required to provide a memory dump of the
system to help IBM technical support personnel analyze the problem. To obtain a
memory dump, you must first set up a dump volume with LVM. You should create the
dump volume immediately after installing OS/2 Warp Server for e-business, so it is
available if you need it.

Dump Volume Requirements

The dump volume must be:

A compatibility volume.
Formatted with the FAT file system.
Larger than the amount of installed RAM on the system by at least 1MB.

Labeled SADUMP (this label refers to the file system volume label, and not to the
volume or partition names you assign in LVM).

Created on the physical drive that is attached to a bootable hard disk controller. If the
dump volume exists on a drive that is not attached to the bootable hard disk
controller (for example, if it is attached to a secondary SCSI controller), then the
system cannot find the volume when the memory dump is taken.

Note: Some systems do not support booting from disks with more than 1024 cylinders.

If you have such a system, then the dump volume must reside within the first
1024 cylinders. If you are not sure about your system, and if you have installed
Boot Manager, you can use LVM to create a bootable volume when you create a
dump volume. If LVM allows the dump volume to be created as bootable, then
the volume is safe for receiving memory dumps. After you have successfully
created the volume as bootable, you can remove it from the Boot Manager
menu, so it is not displayed when the system is started.

Setting Up a Dump Volume

There are three main parts to setting up a dump volume:

1. [Creating the Dump Volume” on page 71|
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2. [Earmatting the Dump Volume']
3. [Setting Up the TRAPDUMP Command

Creating the Dump Volume

To create a dump volume:
1. Open an OS/2 window.
2. Type 1vm and press Enter.
The LVM logical view is displayed.

3. If Boot Manager is not already installed, install it now. See tlnstalling Boat Manager!

for instructions.

4. Create a bootable volume. See [Creating a Boatable Volume” on page 61l for

instructions. Be sure to create the volume at least 1MB larger than the amount of
installed RAM in your system. Be sure to create the volume on a physical drive that
is attached to a bootable hard disk controller.

5. Remove the new volume from the Boot Manager menu. See ERemoving a \Volumg
from the Baot Manager Menu” an page 60 for instructions.

Formatting the Dump Volume

After the dump volume is created, it must be formatted with the FAT file system. To

format the dump volume, see lEarmatting a Volume for a File System after Installationl

for instructions. Be sure to set the volume label as SADUMP.

Setting Up the TRAPDUMP Command

After the dump volume is formatted, you can use the TRAPDUMP statement in the
CONFIG.SYS file to specify under which conditions a memory dump is taken. For more
information about the TRAPDUMP command, see Command Reference or type help
trapdump at an OS/2 command line.

If TRAPDUMP is active, then the system is automatically rebooted after the memory
dump is taken. If you set TRAPDUMP=0OFF, but if you still want your system to
automatically restart in the event of a ring O trap or an internal processing error, add
REIPL=ON to the CONFIG.SYS file. For more information about the REIPL command,
see Command Reference or type help reipl at an OS/2 command line.

Consider using the RO parameter to force automatic dumping only in the event of a ring
0 trap. Otherwise, if ON is specified instead of RO, a ring 3 trap in a noncritical
application will halt the system when the memory dump is taken.

Note: All data that is stored on the dump volume is lost when the memory dump is
taken.
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Formatting a Volume for a File System after Installation

After you create a volume using LVM, whether you create it during or after installation,
you must format it with a file system: Journaled File System (JFS), High Performance
File System (HPFS), or File Allocation Table file system (FAT). For information about

these file systems, see LEile System Descriptions” on page 20.

To format a volume for a file system:

1. From the Desktop, open the OS/2 System folder.
2. Open the Drives folder.
3. Select the volume you want to format.
4. Choose Format Disk from the Selected pull-down menu.
The Format Disk window is displayed.
Type a volume name in the Volume Label entry field.
Select a file system type: JFS, HPFS, or FAT.
7. Click on the Format button.
The Format Progress window is displayed.

o o

8. Click OK when the formatting is complete.
9. Close the Format Disk window.

Resetting Windows and Boot Manager Options

If you install a Microsoft Windows operating system (Windows NT, Windows 98,
Windows 95, or Windows 3.1) after installing OS/2 Warp Server for e-business and
Boot Manager, the system boots directly to the Windows operating system. In other
words, the Boot Manager Startup menu is no longer displayed when you start the
system.

To make the Windows operating system and Boot Manager work together, reset Boot
Manager as startable, and then add the Windows partition to the Boot Manager menu.

Setting Boot Manager as Startable following Windows NT/98/95 Installation

To reset Boot Manager as startable:

1. Insert the OS/2 Warp Server for e-business Installation Diskette into the diskette
drive.

2. Restart the system.
3. Follow the prompts on the screen until the last diskette is processed.

4. When the Welcome! screen is displayed, press F3 to display the command
prompt.

5. Change the drive letter from A: to the drive letter where OS/2 Warp Server for
e-business is installed.

6. Type lvm and press Enter.
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7.
8.
9.
10.
11.
12.

Press Enter to display the Options menu.

Highlight Set Boot Manager startable and press Enter.
Press F3 to exit LVM.

Highlight Save the changes and exit and press Enter.
Remove the Installation Diskette from the diskette drive.
Restart the system.

The system now restarts to Boot Manager.

Adding a Windows Partition to Boot Manager

To add a Windows partition to Boot Manager:

1.
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14.
15.
16.

Open an OS/2 window from the Desktop.

Type Tvm and press Enter.

Press Enter to display the Options menu.

Highlight Create a new volume and press Enter.

Highlight Create a volume that can be made bootable  and press Enter.
Highlight a drive letter in the list and press Enter.

Enter a name for the volume in the space provided and press Enter twice.
Highlight the disk on which the Windows patrtition exists and press Enter.
Highlight Use existing partition and press Enter.

Highlight the Windows partition and press Enter.

Enter a name for the partition in the space provided and press Enter.
Highlight the new volume and press Enter to display the Options menu.

If you do not want OS/2 to have access to the Windows partition, highlight Hide
volume from OS/2 and press Enter.

The new Windows volume is displayed in the logical view with no drive letter and a
status of Bootable.

Highlight Save the changes and exit and press Enter.
Remove the Installation Diskette from the diskette drive.
Restart the system.

After you restart the system, Boot Manager is displayed, allowing you to select any
bootable volume, including the Windows partition.

Creating Installation Diskettes

You must create installation diskettes to start your system and begin the installation
process if your system cannot boot from the OS/2 Warp Server for e-business
Installation CD, or if you need to add device drivers before you begin installation. You
can create installation diskettes on any system that is already started, and that has a
diskette drive and a CD-ROM drive.
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To create installation diskettes:

1.
2.

10.

11.
12.

13.
14.

Gather three blank diskettes and the Server Pak CD.
Label the three diskettes as follows:

* Installation Diskette

* Diskette 1

* Diskette 2

Insert the Server Pak CD into the CD-ROM drive.
Open an OS/2 window.

From an OS/2 command prompt, type e: and press Enter, where e is the drive
letter of the CD-ROM drive.

At the OS/2 command prompt, type cdinst and press Enter.

At the prompt Press any key when ready, press Enter.

Insert the blank diskette labeled Diskette 1 into the diskette drive and press Enter.
The files are copied.

Remove Diskette 1 from the diskette drive and press Enter.

Insert the blank diskette labeled Diskette 2 into the diskette drive and press Enter.
The files are copied.

Remove Diskette 2 from the diskette drive and press Enter.

Insert the blank diskette labeled Installation Diskette into the diskette drive and
press Enter.

The files are copied.

Note: You are prompted to leave the Installation Diskette in the diskette drive and
to reboot the system. Do not follow the prompt. Instead, continue as
instructed below.

Remove the Installation Diskette from the diskette drive and press Enter.
Close the OS/2 window.

Now that the installation diskettes are created, you can either add device drivers to
them, or you can start the OS/2 Warp Server for e-business installation process. To add
device drivers to the diskettes, see Madifying the Installation Diskettes for Newl
Bardwarel To start the installation process, see [Chapter 4 Installing and Configuring

Modifying the Installation Diskettes for New Hardware

OS/2 Warp Server for e-business includes support for many device drivers; however, if
support for your hardware is not included, you will need to create installation diskettes
and then add the necessary device drivers to the installation diskettes before starting
the OS/2 Warp Server for e-business installation. For example, you may have a hard
disk controller with a CD-ROM drive attached that is not supported. If during the
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installation process you receive a message stating that your CD-ROM drive is not
supported, or if you are prompted to insert the CD-ROM, the necessary device driver is
probably not on the installation diskettes.

To locate the device driver you need, either contact the manufacturer of the device or
see the OS/2 Device Driver Pak Online at the following address:

http://service.software.ibm.com/os2ddpak/index.htm

Once you obtain the appropriate device driver, you can modify the installation diskettes
to support new hardware in one of the following ways:

n T N T T = m

If there is not enough space on the mstallatlon diskettes to copy the new device driver,

see

If you want to replace one or more system files with a newer version, see m

”

Adding a Device Driver to the Installation Diskettes

Use this procedure when the device driver is new and was not included with OS/2 Warp
Server for e-business. If there is not enough space on the installation diskettes to copy

the new device driver, see ECreating Space on the Installation Diskettes for Devicd
Drivers” on page 78.

To add a new device driver to the installation diskettes:

1. If your device driver requires a BASEDEV= statement in the CONFIG.SYS file, add
your device driver to Diskette 1. Otherwise, the device driver uses a DEVICE=
statement and needs to be copied to Diskette 2.

2. Modify the CONFIG.SYS file on Diskette 1 as follows:
a. Make sure the following statement exists in the CONFIG.SYS file.
SET SAVECONNECT=1

b. Add the following statement to ensure the device driver is copied throughout the
installation process:

SET COPYFROMFLOPPY=1

c. Add the appropriate statements to the CONFIG.SYS file:
BASEDEV=driver_name <parameters>
DEVICE=driver_name <parameters>

Note: If the connection to the hard disk or CD-ROM drive is lost during the installation

process or when you restart your system, make sure the CD-ROM device driver
statement is in the CONFIG.SYS file on the correct diskette, and make sure the
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CD-ROM device driver is copied to the \OS2\BOOT directory. All device driver
statements must include path information, such as DEVICE=C:\0S2\BOOT\COM. SYS.

Replacing a Device Driver on the Installation Diskettes

Use this procedure to install a newer version of a device driver that was included with
0OS/2 Warp Server for e-business. If there is not enough space on the installation

diskettes to copy the new device driver, see ['Creating Space on the Installation
Diskettes for Device Drivers].

To replace a device driver that resides on Diskette 1 or Diskette 2:

1. Copy the new device driver file over the existing file on Diskette 1 or Diskette 2.
2. Add the following statement to the CONFIG.SYS file on Diskette 1:
SET COPYFROMFLOPPY=1

The installation program uses the new device driver and copies the necessary files to
the target volume.

Adding or Modifying Parameters for Existing Device Drivers

Use this procedure when you need to add or modify parameters to device drivers, and
these parameters must be copied to the target volume during installation.

To add or modify parameters for existing device drivers:
1. Modify the CONFIG.SYS file on Diskette 1 as follows:
a. Add or modify the required parameters to the desired BASEDEV= and
DEVICE= statements.
b. Make sure the following statement exists in the CONFIG.SYS file on Diskette 1:

SET SAVECONNECT=1

The installation program copies the modified lines to the CONFIG.SYS file on the target
volume.

Creating Space on the Installation Diskettes for Device Drivers

If you need to create free space on Diskette 1, depending on your system hardware
configuration, you can try one or more of the following procedures before you copy the
new device drivers to the installation diskettes. For each file you delete from the
diskette, you must also remove the corresponding statement from the CONFIG.SYS file.
» If you are installing OS/2 Warp Server for e-business on a system that does not have
a SCSI adapter, you can delete one or more of the following files to free up to 600KB
of diskette space:
AHA152X.ADD DPT20XX.ADD

AHA154X.ADD FLASHPT.ADD
AHA164X.ADD IBM2SCSI.ADD
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AHA174X.ADD QL160S2.ADD
AIC7770.ADD QL4060S2.ADD
AIC7870.ADD QL510.ADD
AIC78U2.ADD

» If you are installing OS/2 Warp Server for e-business on a SCSI system, you
determine which SCSI adapter you are using, and then remove the SCSI drivers you
are not using.

If you have a problem starting the system after removing the SCSI drivers, you have
removed the wrong drivers from Diskette 1. Copy the SCSI drivers from the original
Diskette 1 to the Diskette 1 you modified.

« If you are not using a RAID array system, you can remove the following files to free
45KB of diskette space:

DAC960.ADD
IPSRAID.ADD

If you need to create free space on Diskette 2, you can remove certain files before you
copy the new device drivers to the installation diskettes. Do not remove any files other
than the ones listed below, or the installation process might have problems.

Remove one or more of the following files to free up to 89KB of diskette space:

TEDIT.EXE
TEDIT.HLP
RMVIEW. EXE
RMINFO.DLL
NPXEMLTR.DLL

Replacing System Files on the Installation Diskette

Use this procedure to install a newer version of one or more system files included on
the Installation Diskette for OS/2 Warp Server for e-business. The system files include
the following:

0S2KRNLI
0S2LDR
0S2LDR.MSG
0S2B0OT

To add a new system file or files to the Installation Diskette:

1. Copy the new system file or files over the existing file or files on the Installation
Diskette.

2. Add the following statement to the CONFIG.SYS file on Diskette 1 to ensure the
new system file or files are copied throughout the installation process:

SET COPYFROMFLOPPY=1
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Installing MPTS with Strong Encryption

A strong encryption replacement version of Multi-Protocol Transport Services (MPTS) is
provided on the OS/2 Warp Server for e-business Security Feature CD 1. This version
of MPTS contains the SSL and IPSEC libraries used by other applications. The IPSEC
libraries provide 56-bit encryption, and the SSL libraries provide 56/128-bit encryption.
This version of MPTS supports strong encryption for Lotus Domino Go Webserver
4.6.2.6 and IBM WebSphere Application Server 1.1.

To install MPTS:

1.

Insert the OS/2 Warp Server for e-business Security Feature CD 1 into the
CD-ROM drive.

Open an OS/2 window.

From an OS/2 command prompt, type e: and press Enter, where e is the drive letter
of the CD-ROM drive.

Type cd mpts and press Enter.

Type cd language and press Enter, where language is the two-character
abbreviation of the language version you are installing.

Use one of the following abbreviations:
* br Brazilian Portuguese

» cx Simplified Chinese

» de German

» dk Danish

* en English

* es Spanish

» fi Finnish

» fr French

* it Italian

* jp Japanese

* nl Dutch

* no Norwegian

» sv Swedish

* tw Traditional Chinese

Type install and press Enter.

Follow the displayed installation instructions.
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Installing Lotus Domino Go Webserver

Lotus Domino Go Webserver 4.6.2.6 is provided on the OS/2 Warp Server for
e-business Security Feature CD 2. Install Lotus Domino Go Webserver before you
install IBM WebSphere Application Server.

To install Lotus Domino Go Webserver:

1. Insert the OS/2 Warp Server for e-business Security Feature CD 2 into the
CD-ROM drive.

2. Open an OS/2 window.

From an OS/2 command prompt, type e: and press Enter, where e is the drive letter
of the CD-ROM drive.

4. Type cd 1dgw and press Enter.

5. Type cd language and press Enter, where language is the three-character
abbreviation of the language version you are installing.

Use one of the following abbreviations:
» cht Traditional Chinese
* chs Simplified Chinese
* deu German
» enu English
* esp Spanish
» fra French
+ ita ltalian
* jpn Japanese
* ptb Brazilian Portuguese
6. Type install and press Enter.

Note: Do not install the Java servlet component if you plan to install IBM
WebSphere Application Server.

7. Follow the displayed installation instructions.
The product README file is also displayed.

More information about Lotus Domino Go Webserver is available at the following
address:

http://www.software.ibm.com/webservers/dgw/doc461.htm

Installing IBM WebSphere Application Server

IBM WebSphere Application Server 1.1 is provided on the OS/2 Warp Server for
e-business Security Feature CD 2. Install Lotus Domino Go Webserver before you
install IBM WebSphere Application Server.
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If you have already installed Lotus Domino Go Webserver, uninstall the Java servlet
component of the Lotus Domino Go Webserver before installing IBM WebSphere
Application Server.

IBM WebSphere Application Server 1.1 requires the latest version of Java 1.1.7. For
instructions about updating Java 1.1.7, see the README.TXT file on the OS/2 Warp
Server for e-business Server Pak CD.

To install IBM WebSphere Application Server:

1. Insert the OS/2 Warp Server for e-business Security Feature CD 2 into the
CD-ROM drive.

Open an OS/2 window.

3. From an OS/2 command prompt, type e: and press Enter, where e: is the drive
letter of the CD-ROM drive.

Type cd wasl_1 and press Enter.

5. Type install and press Enter.

6. Follow the displayed installation instructions.
The product README file is also displayed.

More information about IBM WebSphere Application Server is available at the following
address:

http://www.software.ibm.com/webservers/appserv/library.html

Autostarting Neighborhood Browser Enabler after Installation

Neighborhood Browser Enabler is installed on all servers; however it is not configured
to automatically start (autostart). Neighborhood Browser Enabler should not be
autostarted on every server on which it is installed. At most, it should be autostarted
and run on one server out of every 20 servers in a domain.

To determine if Neighborhood Browser Enabler is running:
1. Open an OS/2 window.
2. Type net start and press Enter.

A list of active services is displayed. If BROWSER is listed, then Neighborhood
Browser Enabler is running. If BROWSER is not listed, then Neighborhood Browser
Enabler is not running.

To start Neighborhood Browser Enabler manually:
1. Open an OS/2 window.
2. Type net start browser and press Enter.

A message stating that the BROWSER service was started successfully is
displayed.

To autostart Neighborhood Browser Enabler:
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1. Open the CAIBMLAN\IBMLAN.INI file (where C: is the installation volume) into a
text editor.

2. Type BROWSER at the end of the SRVSERVICES = line.
Save the IBMLAN.INI file and exit the text editor.
4. Restart the system.

Configuring a PPP Server Ethernet Bridge after Installing OS/2 Warp Server for

e-business

You do not need to configure an Ethernet Bridge if all your remote access clients are
PPP clients.

If you configure an Ethernet Bridge through the LAN Distance Settings notebook,
Settings modifies the PROTOCOL.INI file as follows:

* Replaces the Ethernet adapter in the Bindings statements for NetBEUI and TCPBEUI
with the LAN Distance logical adapter.

* Modifies and deletes statements in the NetBIOS section based on changes to the
Bindings statements for NetBEUI and TCPBEUI.

This reconfiguration might affect your LAN Server configuration.

The following example demonstrates how your LAN Server configuration could be
affected by the configuration of an Ethernet Bridge.

Your system was configured as follows prior to configuration of the Ethernet Bridge:
* The MPTS adapters and protocols configuration panel displays the following:
— IBM LAN Adapter for Ethernet [IBMENI.OS2]...

0 - IBM 0S/2 NetBIOS
0 - IBM TCP/IP
2 - IBM 0S/2 NetBIOS over TCP/IP

— LAN Distance Logical Adapter...

1 - IBM TCP/IP
1 - IBM 0S/2 NetBIOS

» The networks section in the LAN Server configuration file, IBMLAN.INI, contains the
following statements:

netl = NETBEUI$,0,LM10,34,70.14
net2 = NETBEUI$,1,LM10,34,70.14
net3 = TCPBEUI$,2,LM10,34,70.14

After the configuration of the Ethernet Bridge, your system is configured as follows:
* The MPTS adapters and protocols configuration panel displays the following:
— LAN Distance Logical Adapter...

0 - IBM 0S/2 NetBIOS
2 - IBM 0S/2 NetBIOS over TCP/IP
1 - IBM TCP/IP

Chapter 6. Additional Installation and Configuration Options 81



— IBM LAN Adapter for Ethernet [IBMENI.OSZ2]...

1 - IBM TCP/IP
1 - [SR_BRIDGE]

— [BRIDGEFH]...
1 - [SR_BRIDGE]

* The networks section in the LAN Server configuration file, IBMLAN.INI, still contains
the following statements:

netl = NETBEUI$,0,LM10,34,70.14
net2 = NETBEUI$,1,LM10,34,70.14
net3 = TCPBEUI$,2,LM10,34,70.14

With this configuration, the following error is displayed when you shutdown and restart
the system:

NET3406: An error occurred while opening network device drive net2=NETBEUI$
NET3411: There was an error installing NETWKSTA.200

To correct the configuration:
1. Open the OS/2 LAN Services folder.
2. Open the OS/2 LAN Services Installation/Configuration program.

3. Follow the LAN Services Adapters configuration panels until the Adapter and
Protocol Configuration panel is displayed.

4. Add IBM OS/2 NetBIOS and IBM OS/2 NetBIOS over TCP/IP under the Ethernet
adapter.

Note: If you do not make any changes in the configuration panel, the program
automatically corrects the IBMLAN.INI file settings based on your current
adapter and protocol configuration when you apply the changes. However,
remote clients cannot access resources on your LAN for those networks that
are removed.

When you are finished configuring LAN Services, the IBMLAN.INI file remains
unchanged.

The MPTS adapters and protocols configuration panel displays the following:
* IBM LAN Adapter for Ethernet [IBMENI.OS2]...

0 - IBM 0S/2 NetBIOS

0 - IBM TCP/IP

2 - IBM 0S/2 NetBIOS over TCP/IP
0 - [SR_BRIDGE]

* LAN Distance Logical Adapter...

1 - IBM TCP/IP
1 - IBM 0S/2 NetBIOS

+ [BRIDGEFH]..
1 - [SR_BRIDGE]
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Note: For more information about changing these settings after the initial configuration,
see MPTS Configuration Guide.
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Appendix A. File System Comparison Chart

The chart on the following pages compares the characteristics of four file systems: JFS,
386 HPFS, HPFS, and FAT.

Note that when 386 HPFS is installed, it replaces HPFS.
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Appendix B. Troubleshooting Installation Problems

If you experience problems during installation or immediately after installation, use this
section to help you determine the cause of the problem and to find the solution.

If you experience problems after a successful installation of OS/2 Warp Server for
e-business, see Serviceability and Troubleshooting Guide for more information.

CD-ROM Drive Not Detected

If during the installation process you receive a message stating that your CD-ROM drive
is not supported, or if you are prompted to insert the CD-ROM, the necessary device
driver is probably not on the installation diskettes. See EMadifying the Installation
Diskettes for New Hardware” on page 74 for instructions on how to add your CD-ROM
device driver to the installation diskettes. More information about specific CD-ROM
devices is available in Serviceability and Troubleshooting Guide.

VCU Has Detected Corrupt Partitions

The system may issue the following message during installation when Diskette 2 is in
the diskette drive:

"VCU has detected corrupted partition tables on physical drive xx."
"VCU has detected corrupt partitions on 1 or more physical drives. If you
continue, data on these drives may be Tost. It is recommended that you back up

all data before continuing. Do you wish to continue? Y/N"

At this point, the installation process has merely detected the corruption and has not yet
written any data to the drive.

If you choose Y to continue, the installation process removes the corrupt partitions on
the listed drives and allows you to continue. Any existing data on the corrupt partitions
is lost.

If you choose N to stop the installation, the following message is displayed:
"Installation aborted. No volumes have been created. Please refer to the
Installing and Configuring the Server chapter of Quick Beginnings: Installing
0S/2 Warp Server for e-business."

"Press and hold the Ctrl, Alt, and Del keys to reboot."

LVM is more sensitive to discrepancies in the partition table than were previous
versions of OS/2; therefore, previous versions of OS/2 might not have detected the
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corruption. It might be possible to work around this problem by backing up all data on
the affected drives using your existing operating system.

Backing Up Data on a Corrupted Partition during Installation

If you receive the messages described above, perform the following steps:
1. Remove Diskette 2 from the diskette drive.
2. Restart the system.

3. Note the layout of the existing partitions on the drives with the corrupt partitions. If
you are using a previous version of OS/2, you can use the FDISK /QUERY command
to quickly gather this information.

4. Back up all data on all the partitions that are on the physical drives listed as corrupt.
5. Restart the OS/2 Warp Server for e-business installation process as described in

6. When you receive the message indicating that the partitions are corrupt, choose Y
to continue the installation.

7. When the Installation Volume Selection  screen is displayed, select Specify a
different volume . This option executes LVM, where you can re-create the partitions

that were removed. See LSele.cung_the_LnsIallannnAlathe_nn_page_Zd for more

information.

Using the LVM utility, make sure that the correct volume is set as installable, and
make sure there is a drive letter assigned to the volume. See

lnsIaJlaﬂonAlolume_mulh_Logmaulolume_ManagerLan_page_zq for more information.

Be sure to save the changes and exit LVM.

8. Continue the installation as directed.

The disk partitioning is complete. If you are prompted to restart the system so that
the partitions and volumes can be recognized during installation, follow the prompts
on the screen to restart the system and continue installation.

After the system is restarted, follow the prompts until the Installation Volume
Selection screen is displayed. Make sure that the correct installation volume is
displayed, and then select Accept the default volume

After you have selected the installation volume, the Formatting the Installation
Volume screen is displayed. For help with formatting the installation volume, see

9. Restore the data onto the new volumes that you had backed up from the original
partitions.

Partition Cannot Be Made Bootable

If you receive the message "The selected partition cannot be made bootable" while
attempting to create a bootable volume, the following scenario and solution will help you
correct the problem.
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If you want to keep your existing C: drive available with its own operating system, and
then set up D: as the target compatibility volume for installing OS/2 Warp Server for
e-business, you must first install Boot Manager. Only one volume is bootable unless

Boot Manager is installed.

Log Files Created during Installation

Each network component and service produces log files as it is installed. These log files
are stored in subdirectories under \IBMINST\LOGS\. The following tables list the
directory name, file name, and contents of each log file created during installation.

Table 4. Installation Log Files Created in \IBMINST\LOGS Directory

Subdirectory Filename File Contents
CLNDESK.LOG Desktop Shuffler log
TOPINST.LOG Top installation main log
\CONINST\ CONINST.LOG Coninst log
\FFST\ LOCAL.LOG FFST log
\IBMINST\ MKRSP.LOG Building response file log
\TCPAPPS\ TCPINST1.LOG TCP/IP log
\TCPAPPS\ TCPINST2.LOG TCP/IP log
\LOCINSTU\ LOCAL.L2 Network product installation
status, including log of
products installed
\LS\ LOCAL.INS LAN Server installation errors
log
\LS\ LOCAL.SRV LAN Server installation log
\MPTS\ LOCAL.MPT MPTS installation log
\PSNS\ CIDERR.LOG PSnS installation errors log
\PSNS\ CIDHIST.LOG PSnS installation log
\BOOKS\ LOCAL.BKS Books installation log
\NETSCAPE\ LOCAL.NET Netscape installation log
\PPPSRW\ PPP.LOG Remote Access Services
installation log
\PPPSRW\ PPPCFG.LOG Remote Access Services
configuration log
\PSF\ LOCAL.LOG Print Services Facility
installation log
\PSF\ LOCAL.HST Additional Print Services
Facility installation log
\LCFAGENT\ LOCAL.LCF Tivoli Management Agent
(TMA) installation log
\LDAP\ LDAPERR.LOG LDAP installation error log
\LDAP\ LDAPHST.LOG LDAP installation log
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Table 5. Installation Log Files Created in \IBMLANILOGS Directory
Filename File Contents

MESSAGES.LOG LAN Server log

SCHED.LOG LAN Server log

Table 6. Installation Log Files Created in IMMOS2\INSTALL Directory
Filename File Contents

MINSTALL.LOG Multimedia installation and configuration log

Table 7. Installation Log Files Created in \OS2\INSTALL Directory

Filename File Contents
CD.LOG Multimedia detection of CD-ROM information
CURRENT.LOG Log of current installed items by feature install
DSPINSTL.LOG Video display drivers log
FFSTINST.LOG FFST log
IBMLSHST.LOG LAN Server history log
INST_L1.LOG Log created by Netscape
INSTALL.LOG Base installation main log
LAPSHIST.LOG MPTS history log
OS2MM.LOG Multimedia detection of card, windows, etc.
TCPINST.LOG TCP/IP log
WALINST.LOG PPP Server installation module log
WINOS2.LOG WIN-OS/2 installation path log
WPINSTAL.LOG History log of installed items by feature install

Table 8. Installation Log Files Created in \OS2\INSTALLINETSCAPE Directory

Filename File Contents

NETSCAPE.LOG Netscape installation log

Problems During Diskette Portion of Installation

If you experience problems while using the diskettes during installation, perform the
following steps:

1. Place the Installation Diskette in the diskette drive and restart the system.

2. When the white band OS/2 displays in the upper-left corner of the screen, press
Alt+F1.

3. From the Election window, press F6 to disable detection of the hardware.

If the above procedure does not work, perform the following steps to identify the device
driver that is attempting to load during installation:

1. Make a backup copy of your installation diskettes and make the modifications to the
backup diskettes instead of to the original diskettes.
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2. Insert the backup Installation Diskette in the diskette drive and restart the system.

When the white band OS/2 displays in the upper-left corner of the screen, press
Alt+F2 to display the Loading Device Driver window.

4. Edit the CONFIG.SYS file on the backup Installation Diskette and comment out the
statement of the device driver that would not load.

5. Restart the system.

Installing to a Laptop System

Laptop systems, including the IBM ThinkPad series, have rapidly changing hardware
device support. In most cases, you will need to get device drivers for video display,
audio, and PCMCIA devices from your hardware vendor.

It is recommended that you select a VGA display, no audio, and no PCMCIA during the
initial installation of OS/2 Warp Server for e-business on a laptop system. After the
initial installation, you can update and configure the devices using the device drivers
and instructions from your hardware vendor. In many cases, these device drivers are
included with your laptop system, or they are available on the Internet.

You can find device drivers for IBM ThinkPad systems at the following address:

http://service.software.ibm.com/os2ddpak/index.htm

See [Modifying the Installation Diskettes for New Hardware” on page 74| for more

information about updating device drivers after the initial installation.

Problems Installing to an IBM ThinkPad

If you are installing OS/2 Warp Server for e-business on an IBM ThinkPad 600, 760, or
770 series system, you must first disable busmastering for the ThinkPad's IDE
controller. By default, busmastering is enabled. If busmastering is not disabled, the
following problems may occur:

» Extremely slow installation
» Prolonged hard disk activity
» Appearance of system stop during hard disk accesses

To disable busmastering for the ThinkPad'’s IDE controller:
1. Modify the CONFIG.SYS file on Diskette 1 as follows:

a. Change the existing BASEDEV statement from BASEDEV=IBM1S506.ADD to
BASEDEV=IBM1S506.ADD /A:0 /!BM.

b. Verify that the change is still present in the system’s CONFIG.SYS file after the
installation process is completed.
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Display Problems after Installation

Desktop Display Problems

Refresh rate selection for many display drivers is available through the System
object located in the System Setup folder on page 2 of the Screen notebook tab. If
this page does not exist for your display driver and the refresh rate for the resolution
you selected is configured incorrectly, you might experience problems such as:

The Desktop is compressed into a narrow, horizontal band
Multiple images of the Desktop are visible
Diagonal lines fill the Desktop

The video display flickers

It might be possible for you to manually configure the refresh rate using a
configuration utility that may have been provided with your graphics adapter. Follow
the instructions provided by the manufacturer to set the refresh rate.

If the configuration utility is a DOS program, then the utility must be run in a DOS full
screen session and not in a DOS window. When you are finished running a DOS
configuration utility, you must run SVGA ON in the same DOS full screen session to
generate the data file named SVGADATA.PMI. The SVGADATA.PMI file contains
graphics adapter information used in setting modes and refresh rates.

System Error on IBM PC Server with Cirrus Logic Adapter

If you installed the IBM PC Server 320 with MicroChannel BUS and Cirrus Logic
5430 graphics adapter, you might receive a system error when you restart the
system. To prevent this error, obtain a copy of the latest system BIOS from the
following address:

http://www.pc.ibm.com
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Appendix C. Partitioned Removable Media Considerations

LVM supports partitioned removable media (PRM), such as lomega Zip drives and Jaz
drives, as either LVM or compatibility volumes.
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Figure 13. The LVM logical view displays partitioned removable media volumes.

In the figure above, the drive letter preferences are displayed on the left, and the actual
drive letter assignments are diplayed on the right.

Both types of volumes on PRM devices support assignable drive letters with the
following considerations:

» Disk spanning is not supported across removable media. Partitions that are part of a
logical volume that spans disks cannot reside on removable media.

* Removable media volumes have assigned drive letters that are treated as
preferences. When a removable media volume is mounted, its assigned drive letter is
used, if available. Otherwise, the first available drive letter is assigned to the volume.

* If a PRM device contains no media, then no drive letter is assigned to it. This is
different from previous versions of OS/2, where drive letters were always present
whether or not media was inserted.

» If a PRM device contains unformatted media, a temporary volume is created for it,
and the next available drive letter is assigned to it. If you subsequently format the
media without first partitioning it using LVM, the device behaves as if it were a large
diskette (Big Floppy Mode media). For example, it is always assigned the next drive
letter, and it can be formatted only with the FAT file system. This is how these
devices behaved prior to OS/2 Warp Server FixPak 6.

« If a PRM device contains media that has been previously formatted as a large
diskette (Big Floppy Mode media), such as cartridges that were formatted before
0OS/2 Warp Server FixPak 6, it continues to behave as if it were a large diskette.
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< If a PRM device contains media that has partitions defined, but has no volumes
defined (such as partitions created using the PRM support introduced with OS/2
Warp Server FixPak 6 or on a Windows system), LVM creates a temporary volume
for each partition and assigns a temporary, next available drive letter for each
temporary volume. If you subsequently convert a partition to a volume using LVM to
assign a drive letter preference, then only the volumes are mounted. In other words,
the unconverted partitions are no longer mounted after at least one volume has been
defined on the cartridge.

 If you create volumes on a cartridge, the volumes are mounted according to the drive
letters you assigned. Drive letter preferences are stored on the cartridge. Therefore,
if you move the cartridge to another OS/2 Warp Server for e-business system, the
drive letters you assigned to the volumes on the cartridge are always used, provided
there are no conflicts with existing drives on the new system.

* Drive letter preferences are preserved across only OS/2 Warp Server for e-business
systems. If you insert the same cartridge into a legacy OS/2 or Windows system, the
drive letter preferences you assigned to it in LVM are ignored.

+ If a PRM device contains media, and if the media contains volumes, then the
volumes are assigned drive letters. Partitions that do not belong to volumes are
hidden.

» If you make changes to the PRM media using LVM, then all of its temporary volumes
become permanent volumes, and the drive letter preferences are written to the PRM.

« If you eject media from a PRM device, regardless of whether the media is partitioned
or is used as a large diskette (Big Floppy Disk mode), its drive letter disappears and
is available for use. This behavior is different from previous versions of OS/2, where
the drive letters were always present whether or not media was inserted.

* 0S/2 cannot automatically detect when a cartridge is inserted. As a result, you might
need to refresh the Drives object on the Desktop to see the volumes after you insert
the cartridge. OS/2 automatically refreshes drives under the following circumstances:

— When you run LVM in text mode or in GUI mode.
— When you or a program attempts to access a drive letter that does not exist.

* PRM device drives are not refreshed while LVM is running; however, other drives are
refreshed (discovered) while LVM is running.

Note: The category of PRM devices does not include 3.5-inch diskette drives.
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Appendix D. Notices

This information was developed for products and services offered in the U.S.A. IBM
may not offer the products, services, or features discussed in this document in other
countries. Consult your local IBM representative for information on the products and
services currently available in your area. Any reference to an IBM product, program, or
service is not intended to state or imply that only that IBM product, program, or service
may be used. Any functionally equivalent product, program, or service that does not
infringe any IBM intellectual property right may be used instead. However, it is the
user’s responsibility to evaluate and verify the operation of any non-IBM product,
program, or service.

IBM may have patents or pending patent applications covering subject matter in this
document. The furnishing of this document does not give you any license to these
patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other

country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS”
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do
not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes
are periodically made to the information herein; these changes will be incorporated in
new editions of the information. IBM may make improvements and/or changes in the
product(s) and/or the program(s) described in this information at any time without
notice.

Any references in this information to non-IBM Web sites are provided for convenience
only and do not in any manner serve as an endorsement of those Web sites. The
materials at those Web sites are not part of the materials for this IBM product and use
of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs and
other programs (including this one) and (ii) the mutual use of the information which has
been exchanged, should contact:

IBM Corporation
Department LZKS
11400 Burnet Road
Austin, TX 78758
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for
it are provided by IBM under terms of the IBM Customer Agreement, IBM International
Program License Agreement, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment.
Therefore, the results obtained in other operating environments may vary significantly.
Some measurements may have been made on development-level systems and there is
no guarantee that these measurements will be the same on generally available
systems. Furthermore, some measurement may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the
applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM has
not tested those products and cannot confirm the accuracy of performance,
compatibility or any other claims related to non-IBM products. Questions on the
capabilities of non-IBM products should be addressed to the suppliers of those
products.

All statements regarding IBM'’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to
change without notice. Dealer prices may vary.

Trademarks

The following terms are trademarks of International Business Machines Corporation in
the United States, or other countries, or both:

AFP
AIX
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AS/400

IBM

LAN Distance

MPTS

Netfinity

NetView

0S/2

Presentation Manager
Print Services Facility
SystemView
WebSphere
WIN-OS/2

Tivoli, TME 10, and Tivoli Management Environment are trademarks of Tivoli Systems
Inc. in the United States, or other countries, or both.

Lotus and Lotus Notes are trademarks of Lotus Development Corporation in the United
States, or other countries, or both.

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems,
Inc. in the United States and/or other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft
Corporation in the United States and/or other countries.

UNIX is a registered trademark in the United States and/or other countries licensed
exclusively through X/Open Company Limited.

Other company, product, and service names may be trademarks or service marks of
others.
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